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About These Instructions

These instructions for use contain the information necessary to operate your 
BD FACSCanto™ II flow cytometer. Most cytometer functions are controlled by 
BD FACSCanto™ clinical software and BD FACSDiva™ software. BD FACSCanto 
clinical software contains modules for dedicated clinical applications with 
automatic gating algorithms, while BD FACSDiva software is non–application 
specific. Use BD FACSCanto clinical software for performing cytometer quality 
control. 

BD Biosciences recommends that first-time users of this cytometer take 
advantage of operator training offered with the sale of every new cytometer.

The BD FACSCanto II Instructions for Use assumes you have a working 
knowledge of basic Microsoft® Windows® operation.
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Conventions

The following tables list conventions used throughout this guide.

Table 1  Hazard symbolsa

a. Although these symbols appear in color on the cytometer, they are in black and white throughout this docu-
ment; their meaning remains unchanged.

Symbol Meaning

Caution: hazard or unsafe practice that could result in material damage, data 
loss, minor or severe injury, or death

Risk of electric shock

Laser radiation

Biological risk

Table 2  Text and keyboard conventions

Convention Use

! Tip     Highlights features or hints that can save time and prevent 
difficulties

Italics Italics are used to highlight book titles and new or unfamiliar 
terms on their first appearance in the text. 

> The arrow indicates a menu choice. For example, “choose 
File > Print” means to choose Print from the File menu.

Ctrl-X When used with key names, a dash means to press two keys 
simultaneously. For example, Ctrl-P means to hold down the 
Control key while pressing the letter p. 
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Introduction

The BD FACSCanto II system is intended for use as an In Vitro Diagnostic device 
for identification and enumeration of lymphocyte subsets in human cells in 
suspension for flow cytometry.
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System Components and Theory of Operation

The BD FACSCanto II system consists of a flow cytometer, a self-contained 
fluidics cart, and the BD FACSCanto II workstation. System options include an 
automated sample loader and a barcode reader.
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Flow Cytometer Components 

Figure 1-1  BD FACSCanto II flow cytometer

Do not place heavy objects on top of the cytometer at any time; doing so 
could cause alteration of data.

data ports

side door

flow cell
access door

optics
access door

sample 
injection 
tube

fluidics cart
connections

power button

acquisition 
indicator lights
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Fluidics Components

Fluidics Theory of Operation

When you install tubes onto the sample injection tube (SIT), a pump within the 
fluidics cart pressurizes the plenum, which then provides sheath fluid to the flow 
cell. At the same time, the sample tube is pressurized and sample is pushed up the 
SIT and into the flow cell.

When you remove tubes from the SIT, the cytometer cleans the SIT by flushing 
sheath solution down the inside and outside of the tube. The flushed sheath 
solution is aspirated by the aspirator arm.

SIT cleaning between tubes is automatic when you use BD FACSCanto clinical 
software. In BD FACSDiva software, SIT cleaning between tubes is automatic 
unless you disable it by deselecting the SIT Flush checkbox on the Acquisition 
Dashboard.

aspirator arm

tubing

aspirator arm bar

flow cell

tube guide
(Loader option only)

sample injection tube (SIT)

tube eject cylinder
(used with 
Loader option only)

tube sensor
Bal seal access
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Optics Components and Theory of Operation

Once the sample moves into the flow cell, particles move in single file through the 
laser beams. The scattered and emitted light from these particles provides 
information about their size, shape, granularity, and fluorescence properties.

From the flow cell, laser-excited and scattered light is routed to the detector 
arrays, which consist of photomultiplier tubes (PMTs) arranged in one octagon 
and one trigon (a 4-2 optical configuration).

FSC diode

where lasers
intercept
sample stream

obscuration
bar

flow cell
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In the 4-2 configuration, the octagon contains five PMTs and detects light excited 
and scattered by the 488-nm (blue) laser. One PMT in the octagon collects side 
scatter (SSC) signals. The trigon contains two PMTs and detects light excited by 
the 633-nm (red) laser. The 4-2 configuration octagon and trigon arrays have the 
filter and mirror combinations shown in Figure 1-2, and Table 1-1 on page 19.

Figure 1-2  Trigon and octagon detector arrays (4-2 configuration)

longpass 
mirror

bandpass 
filter

red-laser 
signal

trigon

octagon

blue-laser 
signal

PMT
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Blank optical holders do not contain optical filters. They are used in the trigon 
and octagon to prevent unwanted light from interfering with fluorescence signal.

Table 1-1  Trigon and octagon optical filters (4-2 configuration)

Detector Array 
(Laser)

PMT
Position LP Mirror BP Filter or 

LP Mirror Intended Dye

Octagon 
(488-nm blue laser)

A 735 780/60 PE-Cy™7

B 655 670 PerCP-Cy™5.5 
or PerCP

C 610 blank 
optical holder

—

D 556 585/42 PE

E 502 530/30 FITC

F blank 
optical holder

488/10
and pinhole

SSC

G blank 
optical holder

blank 
optical holder

—

H — blank 
optical holder

—

Trigon 
(633-nm red laser)

A 735 780/60 APC-Cy7 

B 685 blank 
optical holder

—

C — 660/20 APC
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Electronics Components

Power to the cytometer, lasers, and fluidics cart is supplied by a power cord from 
the cytometer plugged directly into a standard electrical outlet. BD recommends 
using an uninterrupted power supply (UPS) unit to maintain cytometer power 
during a power outage. The system power button turns on the cytometer and 
fluidics cart, and powers the lasers.

NOTICE     If a power failure occurs during a run, sample can leak from the SIT. To 
prevent a biohazardous spill, place an empty tube on the SIT. Once power is 
restored, remove the tube and perform a fluidics startup before resuming the run.

Figure 1-3  Flow cytometer power panel 

The system circuit breaker is located next to the AC power cord. The breaker will 
need to be reset if there is a power surge in the laboratory.

Acquisition indicator lights are located on the flow cell access cover on the front 
of the cytometer (see Figure 1-4 on page 21). Each light corresponds to a detector 
in the collection optics subsystem, and blinks when the signal at that detector 
reaches a preset level. Acquisition threshold levels (set using the software) 
override the presets. See Figure 1-5 on page 21.

Lights are activated only when the system is acquiring data, and only the 
indicators corresponding to currently active parameters will blink.

system circuit breaker

system power 
button

system AC power
cord plugs in here

power out to 
fluidics cart

communication 
cable to fluidics cart
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Figure 1-4  Detector order of acquisition indicator lights

The acquisition indicator lights can be switched off. The on/off switch is located 
inside the flow cell access cover.

Figure 1-5  Acquisition indicator light switch
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Fluidics Cart

The fluidics cart provides filtered sheath and cleaning fluids to the cytometer, and 
collects system waste products. The cart supplies the required air pressure and 
vacuum, which eliminates the need for an external source (although the cart can 
be hooked up to an in-house air source).

Figure 1-6  Fluidics cart

10-L waste 
container

BD FACSFlow
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door access
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Containers and Ports

BD FACSFlow cubitainer

BD FACSFlow port

BD FACS shutdown solution 
port and cubitainer

BD FACSClean solution port 
and cubitainer

waste
container

waste port

fluidics filters



24 BD FACSCanto II Instructions for Use

Controls

The fluidics cart connects to the flow cytometer unit by way of cables and tubing. 
When you turn on the power to the cytometer, the fluidics cart powers on also. 
Under ordinary circumstances, you do not need to adjust any of the switches on 
the cart’s power panel. Leave the auxiliary air supply switch off unless the cart 
has been attached to an in-house air supply by BD Biosciences service personnel. 
Leave the cart circuit breaker on at all times.

Figure 1-7  Fluidics cart panel

Condensation Trap

The fluidics cart condensation trap is located beneath the controls panel (see 
Figure 1-6 on page 22). Empty the trap during the daily shutdown procedure.

Air Pressure

auxiliary air supply switch

cart circuit breaker
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BD FACS Loader (Optional)

The BD FACS™ Loader automatically introduces prepared samples to the 
cytometer. Two sliding doors protect you from moving parts during operation. 
The Loader is controlled by BD FACSCanto clinical software or BD FACSDiva 
software. 
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Carousel

The carousel accommodates up to forty 12 x 75-mm tubes. Each carousel has a 
unique ID printed on top and on an optically read label inside.

Figure 1-8  Sample-Prep Ready carousel

NOTICE     The Loader is compatible only with the green-tinted carousels labeled 
“Sample Prep Ready” (Figure 1-8).

Not all manufactured 12 x 75-mm tubes have been checked for proper 
functionality on the Loader. BD Biosciences has validated only disposable, 
12 x 75-mm BD Falcon polystyrene test tubes, BD Trucount tubes, and 
BD FACS 7-color setup bead tubes.

alignment hole

spindle hole
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Barcode Reader (Optional)

The Opticon LG2 Imager is a hand-held barcode reader that plugs into the USB 
port on the BD FACSCanto II computer workstation.

The barcode reader reads most barcode standards, including Codabar, Code 128, 
Code 39 with checksum, and PDF417. It reads information from the BD FACS™ 
7-color setup beads label into BD FACSCanto clinical software, and also reads 
coded patient information into a worklist. For operating instructions, see 
Chapter 3 on page 39.

Figure 1-9  Typical barcode reader (example)

ready light

view from top

trigger
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System Requirements

Software

Both included software packages must be installed:

• BD FACSCanto clinical software v2.1

• BD FACSDiva software v6.0

NOTICE     BD FACSDiva software v6.0 must be installed for BD FACSCanto 
clinical software v2.1 to operate.

Workstation

BD FACSCanto II workstation purchased through BD Biosciences

Compatible Tubes

• 12 x 75-mm polystyrene test tubes (BD Falcon™ tubes)

• 12 x 75-mm BD Trucount™ tubes

• BD FACS™ 7-color setup bead tubes

Bulk Fluids

• BD FACSFlow solution

• BD™ FACSClean solution

• BD FACS™ shutdown solution

• bleach (waste container)

Do not read FCS files created with v2.1 into previous versions of 
BD FACSCanto clinical software. Previous versions will show incorrect results.
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Fluids Required for External Cleaning

• BD FACSClean solution

• Deionized (DI) water

Setup Beads

BD FACS 7-color setup beads for use with BD FACSCanto clinical software
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Software Windows and Toolbars

• BD FACSCanto Clinical Software Workspace on page 32

• BD FACSCanto Toolbars on page 33

• BD FACSDiva Software Workspace on page 34
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BD FACSCanto Clinical Software Workspace

After you log in, the main window appears. Table 2-2 provides a brief overview 
of window components.

Table 2-2  Main window components

Component Function

a. menu bar Contains the File, View, Worklist, Cytometer, Tools, 
and Help menus

b. toolbars Contains buttons that provide quick access to menu 
commands; see BD FACSCanto Toolbars on page 33.

a

c

e

f

g

h

i

b

d
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BD FACSCanto Toolbars

c. workspace Displays the Worklist, Acquisition, Lab Report, and 
Levey-Jennings tabs, depending on where you are in 
the workflow

d. status bar Provides information about the flow cytometer’s 
current state, the cytometer-software connection, and 
the amount of time elapsed since logon

e. Minimize, Maximize, and 
Close buttons (in title bar)

Minimize button—reduces the application to a button 
on the Windows taskbar

Maximize button—fills the screen with the main 
window

Close button—exits the application and prompts the 
Fluidics Shutdown procedure

f. Carousel window Shows a graphic representation of a carousel rack and 
the rack ID of the currently selected sample

g. Status window Provides information on the current status of the flow 
cytometer

h. cytometer control windows Includes three tabs:

• Detectors tab

• Thresholds tab

• Spectral Overlap tab

i. docking area Provides a default home for the Carousel, Status, and 
cytometer control windows

Table 2-2  Main window components (continued)

Component Function

optimizelogout new acq. 
worklist

new anal. 
worklist

open 
worklist

save print run pause stop skip end 
recording

Standard toolbar Worklist toolbar
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BD FACSDiva Software Workspace

After you log in, the workspace appears, showing the main application windows 
(Figure 2-10). Hide or show windows by clicking buttons in the Workspace 
toolbar (  in the figure).

Figure 2-10  BD FACSDiva workspace

y

Click a button in the Workspace toolbar to hide or show the corresponding 
window. Most windows can be resized by dragging a border or corner.

1

1

2 4

3

5

6

1
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The Browser lists folders, experiments, 
and experimental elements in a 
hierarchical view, provides an interface 
for setting up experiments, and contains 
a current tube pointer (c) indicating the 
tube for which acquisition or analysis 
data will be shown.

Only one experiment can be open at a 
time. In an open experiment, you can 
add, rename, or copy elements, and 
record or display data.

Click a button in the Browser toolbar (a) to add elements to the Browser. To 
display a particular experiment, enter a term in the search field (b) and click the 
Find button (d).

The Acquisition Dashboard contains controls for setting up, starting, monitoring 
data acquisition and recording, and running the Loader. Basic controls are always 
shown. Carousel Controls (e), Acquisition Setup (f), and Acquisition Status (g) can 
be hidden or shown by right-clicking anywhere on the Dashboard (except buttons 
and fields or in Basic Controls) to display the Show/Hide menu and making your 
selection. You can resize the Dashboard by dragging an edge or corner of the 
window. 

2

a

c

b

d

3

e

g

f
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The Cytometer window shows the 
cytometer connectivity status. When the 
cytometer is connected, the window also 
shows status messages. If an experiment is 
open and the current tube pointer is set, the 
window displays cytometer settings for the 
current acquisition tube and laser controls. 

Additional controls might be displayed in 
this window depending on the cytometer 
you are running. Refer to your cytometer 
manual for a description.

Use the Inspector to view or modify the 
attributes of one or more objects in the 
worksheet or Browser. The contents of the 
Inspector change depending on what is 
selected. For example, this Inspector shows 
plot options.

4

5
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The Worksheet window is where you create global or normal worksheets 
containing plots, gates, statistics, and custom text. 

Plots on a global worksheet show data for the tube selected with the current tube 
pointer. Global worksheets are indicated by green tabs (a). Plots on a normal 
worksheet are tube specific. Normal worksheets are indicated by white tabs for 
active worksheets and gray tabs for inactive worksheets.

Click the button in the Worksheet toolbar (b) to switch between the global or 
normal worksheets view. Then you can create analysis objects or text, or align 
objects on a worksheet.

Unlike other workspace windows, the 
Biexponential Editor is hidden by default. 
When you are using automatic scaling, there 
is no need to show the Biexponential Editor.

Use the Biexponential Editor to manually 
adjust biexponential scales, export and 
import scale values, and apply values to other 
elements in an experiment.

6

b

a
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Barcode Reader Option

This chapter contains the following information:

• Installing and Using the Barcode Reader on page 40

• Cleaning the Barcode Reader on page 42

• Barcode Symbologies on page 43
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Installing and Using the Barcode Reader

NOTICE     The Opticon LG2 Imager 2D barcode reader available for the 
BD FACSCanto II system is capable of reading both 1D and 2D barcode 
symbologies. See Barcode Symbologies on page 43.

The BD FACSCanto II system supports only two uses of the 2D barcode reader:

• reading information from the BD FACS 7-color setup beads label into 
BD FACSCanto clinical software (2D barcode symbology)

• reading coded patient information from sample tube labels into a worklist 
(1D barcode symbology) 

NOTICE     The barcode reader supplied with the BD FACS™ Sample Prep 
Assistant II (SPA II) is a 1D reader that cannot read information from 
BD FACS 7-color setup beads. Use only the Opticon LG2 Imager 2D barcode 
reader for reading information from the BD FACS 7-color setup beads label into 
BD FACSCanto clinical software.

NOTICE     Contact BD Biosciences before changing default barcode settings.

To prevent laser injury, do not stare into the reader or aim it at another 
person’s eyes while the trigger is depressed.
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1 Plug the barcode reader into a USB port on your computer.

The reader turns on automatically.

2 Make sure the green light on top of the reader is illuminated:

3 In BD FACSCanto clinical software, navigate to the fields for which 
information can be scanned.

• Lot information for BD FACS 7-color setup beads is scanned into the 
Setup Lot Information dialog from the setup values label supplied with 
the setup bead kit (NOT from the lot number on the setup bead tubes). 
See Entering Lot Information with the Barcode Reader on page 53.

• Patient information is scanned from sample labels into the worklist ID 
field.

4 Locate the barcode on the setup values label of BD FACS 7-color setup 
beads kit, or on the patient sample.

! Tip     To make it easier to use, an optional stand is available for the barcode 
reader. See Barcode Reader Parts on page 229.

For accurate results, do not photocopy or enlarge the barcodes that are 
included with the reagent. Scan the barcodes exactly as they are provided.

green light
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5 Aim the barcode reader at the center of the barcode. The barcode reader 
has two focal lengths, 10 cm and 23 cm (4 in. and 9 in.):

• For reading BD FACS 7-color setup bead labels, hold the barcode 
reader 23 cm (9 in.) from the labels.

• For reading patient information from sample tube labels, hold the 
barcode reader 10 cm (4 in.) from the labels.

6 Press and hold the trigger on the barcode reader until you hear a beep.

If the reader does not beep, adjust your distance from the barcode while 
continuing to hold the trigger. 

! Tip     To obtain a reading, keep the bar code reader aimed at the center of 
the label. Do NOT sweep across the label.

7 Compare software field values with the setup beads or sample label.

Cleaning the Barcode Reader

For best performance, keep the front window of the barcode reader clean. Do not 
touch the window directly, and wipe it only with a soft, non-abrasive cloth 
moistened with one of the following:

• isopropyl alcohol

• ethyl alcohol (denatured grade)

To prevent laser injury, do not stare into the reader or aim it at another 
person’s eyes while the trigger is depressed.

Do not use BD FACSClean solution or bleach to clean or disinfect the 
barcode reader.
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Barcode Symbologies

Although data entry using barcodes is generally more reliable than manual data 
entry, it is not guaranteed to be 100% accurate. To increase accuracy, use of 
barcode symbology checksums is recommended.

1D Barcode Symbologies

BD Biosciences has evaluated the following 1D barcode symbologies for use with 
the BD FACSCanto II flow cytometer, and has these recommendations:

Using barcode symbologies with checksums disabled increases the 
likelihood of incorrect information transfer, including sample ID 
assignments. This can result in a mismatch of sample IDs and sample 
results.

By default, the barcode reader has checksums enabled. We recommend you 
do not disable checksums, or use barcode symbologies without checksums.

Barcode Symbology Recommendation

Code 128 Preferred.

Code 39 Acceptable if barcode labels are printed with the checksum 
digit. By default, the barcode reader recognizes the checksum 
digit when reading the Code 39 symbology. However, if labels 
are printed without a checksum digit, contact your BD service 
representative for instructions on disabling the checksum 
feature.

Codabar The barcode reader does not support the checksum feature 
when reading the Codabar symbology.
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2D Barcode Symbologies

BD Biosciences has evaluated 2D barcode symbology to read the target values of 
BD FACS 7-color setup beads when using BD FACSCanto clinical software. 2D 
barcode symbology is required to read all target values with one scan.
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Starting Up

This chapter describes cytometer startup for both BD FACSCanto clinical 
software and BD FACSDiva software.

1 Turn on the power to the cytometer.

Figure 4-1  Flow cytometer power panel

The system power button turns on power to the cytometer, fluidics cart, 
and lasers.

system power 
button
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2 Start up the computer, launch the software, and log in.

3 Make sure the software is connected to the cytometer.

If needed, choose Cytometer > Connect.

BD FACSCanto
BD FACSDiva
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4 Check fluid levels.

Low fluid levels or a full waste container are indicated in red.

5 If fluidics startup does not start automatically, choose Cytometer > Fluidics 
Startup.

6 Click OK at the confirmation dialog.

7 When Fluidics Startup finishes, click OK to close the dialog.

To prevent fluid overflow, make sure there is no tube on the SIT at startup.

FACSFlow

BD FACSCanto 

BD FACSDiva

waste

shutdown 
solution

cleaning solution 
(empty)
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8 Lift the flow cell access door to check the flow cell for air bubbles.

Figure 4-2  Flow cell

• If you see bubbles choose Cytometer > Cleaning Modes > De-gas Flow 
Cell.

• Click OK when the completion message appears.

• If you still see bubbles, repeat.

An error message might appear when you open the flow cell access door. To 
dismiss the message, close the door and wait 30 seconds.

9 Check that laser warmup has finished.

check here for 
bubbles

BD FACSCanto

BD FACSDiva
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Cytometer QC and Setup

This chapter describes how to perform cytometer QC and setup.

• Performing Automated Setup on page 50

• Optimizing with BD FACSCanto Clinical Software on page 64

• Optimizing with BD FACSDiva Software on page 76
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Performing Automated Setup

Whether you run samples in BD FACSCanto clinical software or BD FACSDiva 
software, use BD FACSCanto clinical software to run automated setup and QC.

During setup, detector voltages are adjusted to place setup beads at defined target 
values, sensitivity values are measured, and spectral overlap values are calculated 
and applied to compensate data for fluorescence spillover. Use the Levey-Jennings 
feature in BD FACSCanto clinical software to automatically track cytometer 
setup values over time, and to monitor cytometer performance and see shifts or 
trends in parameters as they occur. 

Run setup once every 24 hours, using BD FACS 7-color setup beads. The 
software tracks the time between setups and displays it in the Status window. A 
setup age of more than 24 hours appears in red. Running a successful setup resets 
the timer. 

NOTICE     If the software fails to respond during acquisition and you need to 
restart the software, perform a fluidics startup prior to resuming acquisition. See 
BD FACSCanto Software General Issues on page 199 for more information.

time since 
last setup
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Running Setup Using Manual Loading

1 Prepare BD FACS 7-color setup beads (refer to the instructions supplied 
with the beads).

2 Prepare the cytometer for manual loading.

Do not use expired beads. Doing so can cause incorrect setup results.

tube guide pushed back

aspirator arm bar vertical

drawer pulled out

carousel removed

1

2

3

4

3

4

2

1
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3 Choose Cytometer > Setup > Standard Setup.

4 Select the current bead lot from the Lot ID menu.

Figure 5-1  Setup Lot Information window

5 Check lot ID, targets, and spectral overlap factors in the Cytometer Setup 
Wizard against the BD FACS 7-color setup beads label. If necessary, enter 
new values into the Wizard. 

See Figure 5-2 on page 53 for an example BD FACS 7-color setup beads 
label.
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Figure 5-2  Setup beads label (example)

• To enter values with the barcode reader, go to the next section.

• To enter values with the keyboard and mouse, go to page 55.

If you do not need to enter new values, go to Loading Tubes on page 56.

Entering Lot Information with the Barcode Reader

Although data entry using barcodes is generally more reliable than manual data 
entry, it is not guaranteed to be 100% accurate. To increase accuracy when using 
the barcode reader, enabling the checksum feature is recommended. For more 
information on using the barcode reader, see Chapter 3.

1 Click  in the Setup Lot Information window of the Wizard 
(Figure 5-1).

The Scan Barcode dialog appears (Figure 5-3).
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Figure 5-3  Scan Barcode dialog

2 Locate the barcode on the BD FACS 7-color setup beads label.

See Figure 5-2 for an example label.

3 Hold the barcode reader 23 cm (9 in.) from the BD FACS 7-color setup 
beads label and aim the barcode reader at the center of the barcode.

4 Press and hold the trigger on the barcode reader until you hear a beep. 

The progress bar fills and the dialog closes when you successfully scan the 
barcode.

If the reader does not beep, adjust your distance from the barcode while 
continuing to hold the trigger.

If the barcode reader is used in a manner not specified by BD Biosciences, 
the inherent safeguards provided may be impaired.

To prevent laser injury, do not stare into the beams or aim the scanner at 
another person’s eyes while the trigger is depressed.
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5 Check software entries for accuracy of reading the setup beads label.

6 Go to Loading Tubes on page 56.

Entering New Lot Information with the Keyboard

1 Click  in the Setup Lot Information window of the Wizard 
(Figure 5-1 on page 52).

2 Choose the bead product, enter the lot ID and the expiration date, and 
click OK.

The lot ID and expiration date are on the setup beads label.

3 Enter the target values for the bead lot.

Select the current value in the Target Value field and enter the new value. 
Repeat until you have edited all target values.

Do not use the barcode on the tube.
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4 Click the Spectral Overlap Factors tab, and enter the spectral overlap 
factors for the bead lot.

Select a current value and enter the new value. Repeat until you have edited 
all spectral overlap factors.

Loading Tubes

1 Click .

2 If the Save Setup Bead Lot Info dialog appears, click .

This dialog appears only if you changed lot ID values.

3 Select Run setup in Manual mode, and click .

See Figure 5-4 on page 57. 
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Figure 5-4  Insert Setup Tube dialog

 

4 When prompted, load the beads tube onto the SIT, using these steps:

• Push the aspirator arm to the left.

• Place the beads tube on the SIT, ensure the tube is straight, and firmly 
push up until the tube comes to a complete stop and is fully seated.

• Center the aspirator arm under the beads tube. There are three sensor 
pins on the aspirator arm. The bottom of the tube should sit within the 
center of the pins.

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.
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5 Click .

If the tube is not fully seated, the following error message appears. Click 
OK. Remove the tube and repeat step 4 to properly reinstall it.

6 Wait for setup to finish.

The software adjusts cytometer settings to place the beads on scale. Note 
that it is normal for the beads to move to the baseline and back on scale 
during this process.

symbols key

completed

undone

in process
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7 Unload the beads tube when prompted, using these steps:

• Hold the sample tube while pushing the aspirator arm to the left. 

• Remove the tube from the SIT.

• Release the aspirator arm.

SIT cleaning occurs when the aspirator arm comes to center. 

8 Decide what to do next:

• If setup is unsuccessful or if setup results are out of range, do not click 
Finish. Note the message provided by the software (eg, Figure 5-5 on 
page 60) and consult BD FACSCanto Clinical Software 
Troubleshooting on page 199.

• If setup is successful, see Table 5-1 on page 60.

NOTICE     It is important to monitor setup data for trends. See Reviewing 
Levey-Jennings Reports on page 74.

Incorrect values are saved if you accept a setup that is unsuccessful or setup 
results that are out of range.
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Figure 5-5  Successful Setup Complete dialog

Table 5-1  Options after Setup

To... Click... Additional Information

View setup results The report contains cytometer 
QC and pass/fail information. 
You can print the report from 
this view.

Discard current results You will be given the option to 
use the last setup results.

Run setup again

Optimize setup values 
using BD FACSCanto 
clinical software When prompted, 

click  to 
save your results 
and continue.

Proceed to Optimizing with 
BD FACSCanto Clinical 
Software on page 64.
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Running Setup Using the Loader

1 Prepare BD FACS 7-color setup beads (refer to the instructions supplied 
with the beads).

NOTICE     Do not use setup beads after their expiration date. Doing so can 
cause incorrect setup results.

2 Prepare the cytometer for automatic loading (Figure 8-3 on page 136).

3 Choose Cytometer > Setup > Standard Setup.

The Cytometer Setup Wizard appears.

4 Select the current bead lot from the Lot ID drop-down menu.

5 Check the Lot ID, Targets, and Spectral Overlap Factors in the Cytometer 
Setup Wizard against the BD FACS 7-color setup beads label. 

Exit setup and save new 
setup results

The software calculates and 
saves lyse/wash and lyse/no-
wash setups that you can use 
with BD FACSCanto clinical 
software or BD FACSDiva 
software. PDF files of Setup 
Reports are automatically 
saved in C:\Program Files\BD 
FACSCanto Software\ 
SetupReports folder.

(Optional) Save setup 
results and optimize setup 
values using 
BD FACSDiva software

Proceed to Optimizing with 
BD FACSDiva Software on 
page 76.

Table 5-1  Options after Setup

To... Click... Additional Information
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6 Enter new values into the Wizard; Click .

See page 53 for how to enter information with the barcode reader.

7 If the Save Setup Bead Lot Info dialog appears, click .

This dialog appears only if you changed lot ID values.

8 Place the bead tube in position 1 of a carousel and the optimization tubes in 
the positions following.

For instructions, see step 3 on page 137.

9 Install the carousel onto the Loader.

For instructions, see step 4 on page 137 and step 5 on page 138.

10 Deselect Run setup in Manual mode, and click .
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11 Wait for setup to finish.

The software adjusts cytometer settings to place the beads on scale. Note 
that it is normal for the beads to move to the baseline and back on scale 
during this process.

12 Decide what to do next:

• If Setup is unsuccessful or if setup results are out of range, do not click 
Finish. Note the message provided by the software (see Figure 5-5 on 
page 60) and consult BD FACSCanto Clinical Software 
Troubleshooting on page 199.

• If setup is successful, see Table 5-1 on page 60.

13 It is important to monitor setup data for trends. See Reviewing Levey-
Jennings Reports on page 74.

14 If you are using BD FACSDiva software to acquire samples, close 
BD FACSCanto clinical software.

Incorrect values are saved if you accept a setup that is unsuccessful or setup 
results that are out of range.

symbol key

completed

undone

in process
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Optimizing with BD FACSCanto Clinical Software

During optimization, you can adjust thresholds, detector voltages, and spectral 
overlap values for a panel type. The software uses BD Biosciences default settings 
the first time you optimize. When you make changes, the new settings apply to all 
tubes and samples of this panel type. 

NOTICE     If the software fails to respond during acquisition and you need to 
restart the software, perform a fluidics startup prior to resuming acquisition. See 
BD FACSCanto Software General Issues on page 199 for more information.

1 Select a panel type and parameters from the menus and click .

Gate Parameter X and Gate Parameter Y refer to the plot parameters for 
the first optimization plot, the plot that contains a gate around the cells of 
interest.
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2 (Loader only) Make sure the optimization tubes are installed in the correct 
carousel positions, and click .

3 Click .
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4 (Manual only) Install the first optimization tube when prompted, and click 
.

5 At the Cytometer Setup Optimization screen, click .

• Acquisition begins, and events appear in the plots. 

• Right-click the axis labels on a plot to choose other parameters.
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6 Optimize settings, as needed.

! Tip     Threshold and side scatter are the most frequently optimized 
parameters for TBNK assays.

• To adjust the optimization gate, click —the acquisition 
display stops updating. Move the gate by dragging the gate border, or 
resize the gate by selecting a corner and dragging. When you are ready 
to proceed, click .

• To adjust detectors, thresholds, or spectral overlap settings, click on the 
corresponding tab. Use controls in the tab to adjust the settings. For 
instructions, see Using Cytometer Controls on page 71.

! Tip     Spectral overlap values are automatically recalculated when you adjust 
voltages.

For clinical applications that use tandem conjugates such as APC-Cy7 or 
PE-Cy7, spectral overlap varies from lot to lot. Because BD FACSCanto 
clinical software setup targets the average lot, you might need to adjust 
spectral overlap settings for these reagents. 
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7 If there are more tubes, click , and then .

If this is the last tube, proceed to step 11 on page 69.

(Manual only) Remove the current tube when prompted, using the 
following method:

• When the aspirator arm lowers, hold your sample tube while you push 
the aspirator arm to the left.

• Remove the tube from the SIT.

• Release the aspirator arm.

SIT cleaning occurs when the aspirator arm comes to center.

NOTICE     To prevent backflow into the tube, follow the tube removal 
sequence exactly. For more information, see Cytometer Troubleshooting on 
page 190.

8 (Manual only) When prompted, place the next tube on the SIT, and click 
.

9 Repeat steps 3 through 6. 

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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10 (Optional) To view the Application Setup Report, click , and 
then .

The Application Setup Report reflects the optimized settings.

Click  in the toolbar to print the report. 

! Tip     You can also save an electronic copy of the report and print it later. 
When you click Save, the software automatically saves PDF files of 
Application Setup Reports in C:\Program Files\BD FACSCanto 
Software\SetupReports.

11 When there are no more tubes to optimize, click , and then 
.

Optimized setup results are saved to the panel name.opt file in the 
C:\Program Files\Common Files\BD\Setup Results folder. (For example, 
4-color TBNK optimized setups are saved to the 4 color TBNK.opt file and 
6-color TBNK optimized setups are saved to the 6 color TBNK.opt file.)

12 Unload the setup tube or remove the carousel.

13 Click .

Changes will be saved for future setups. See the table on page 70 for instructions 
on saving user-specific optimization settings or reverting to default settings.
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Maintaining User-Specific Optimization Settings

To.... Do This.... Additional 
Information

Maintain settings for 
a single user

1 Run setup.

2 Select an application and optimize.

User-optimized setup 
is calculated for the 
selected application 
and panel type.

Maintain settings for 
multiple users

1 Copy the panel type.opt file.

2 Rename it with a unique name (eg, 4 
color TBNK_username.opt), and save 
it in your choice of location. 

3 To use your optimized results, quit the 
software, rename the file with its 
original file name (eg, 4 color 
TBNK.opt or 6 color TBNK.opt), and 
move it back into the Setup Results 
folder.

4 When prompted, overwrite the 
current file.

5 Restart the software, and run setup.

The file is in 
C:\Program 
Files\Common 
Files\BD\Setup 
Results.

Restore 
BD Biosciences 
default settings

1 While the software is not running, 
delete the panel type.opt file.

2 Restart the software, and run setup.

The software 
automatically 
rebuilds the panel 
type.opt file with BD- 
defined settings.
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Using Cytometer Controls

Cytometer controls are disabled when a worklist is running. You can adjust 
controls only during optimization (immediately after Setup), or after pausing 
sample acquisition during a worklist run.

There are three types of cytometer controls: Detectors, Thresholds, and Spectral 
Overlap. Click on a tab to access the corresponding controls, or choose an option 
from the View menu.

Adjusting Detectors

Adjust the signal for events displayed in plots by changing detector voltages. 
Higher voltages amplify the signal. Lower voltages decrease the signal. 
BD FACSCanto clinical software automatically recalculates spectral overlap 
when you change detector voltages.

To change a setting, click in the field containing the value you want to change. Up 
and down arrows and a  appear. Change the value as follows:

• highlight the value and type in a new one

• click the up and down arrows

tabs

tabs

after Setup, in Wizard during acquisition
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• click the , and drag the pointer to a new setting

• press Ctrl-"/# to adjust settings in minor increments, or Ctrl-Page Up/
Page Down to adjust settings in larger increments

Adjusting Thresholds

Use thresholds to filter out unwanted events: a threshold sets a channel number 
below which events will not be processed. You can set one or more thresholds at 
a time, and choose whether any one (OR) or all (AND) need to be met. 

To set a threshold:

1 Enable a parameter as a threshold by selecting the checkbox beside it. 

2 Click in the associated Value field to set the threshold value (Figure 5-6 on 
page 73).

Use one of the editing methods specified in Adjusting Detectors on page 71.

pointer
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Figure 5-6  Adjusting Threshold

3 (Optional) Enable and set another threshold parameter.

• Select the associated checkbox.

• Edit the threshold value.

• Select Or (any of the parameter thresholds can be met) or And (all of 
the parameter thresholds must be met).

Adjusting Spectral Overlap

Fluorochromes emit light over a range of wavelengths. During cytometer setup, 
fluorescence spillover is automatically determined and corrected. If necessary, 
you can use the spectral overlap controls to make manual adjustments:

1 Click in the Spillover % value field that needs correction (Figure 5-7 on 
page 74). 

2 Use one of the editing methods specified in Adjusting Detectors on page 71.

pointer
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Figure 5-7  Adjusting Spectral Overlap

Reviewing Levey-Jennings Reports

The software automatically creates a Levey-Jennings Report from the cytometer 
setup data. To view the report:

1 From the main window, select the Levey-Jennings tab.

An  on the tab indicates an 
out-of-range value on the report: 
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2 Check the plots in the report.

Parameters outside the limits set by the lab manager are shown by a red x 
in the affected plot. 

3 To add comments to the report, click Comments:

Enter text into the Comments field (up to 2500 characters), and click OK. 
See Figure 5-8 on page 76.
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Figure 5-8  Enter Lab Report Comments

4 To print the report, Click .

Optimizing with BD FACSDiva Software

To optimize cytometer settings in BD FACSDiva software:

1 Quit BD FACSCanto clinical software, if necessary.

2 Select Exit only, and click .

3 Launch BD FACSDiva software, enter your user name and password, and 
click OK.
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Verifying Cytometer Configuration and User 
Preferences

1 Choose Cytometer > View Configurations and verify the current 
parameters.

If changes are necessary, contact your Lab Manager.

2 Verify that the filters are appropriate to run FITC, PE, PerCP-Cy5.5, 
PE-Cy7, APC, and APC-Cy7 fluorochromes.

3 Choose Edit > User Preferences and deselect all options in the General tab.

See Figure 5-9 on page 78.

Do not change the cytometer configuration without consulting 
BD Biosciences. Doing so can invalidate results.

For accurate data results, the octagon and trigon arrays must match the 
current Cytometer Configuration.
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Figure 5-9  User Preferences General tab

4 Click OK to save the changes.

Creating the Experiment

1 Click the corresponding buttons in the Workspace toolbar to display the 
Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), 
Acquisition Dashboard ( ), and Biexponential Editor ( ) windows as 
needed.
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2 (Optional) Create a folder:

Select your database icon in the Browser, and click  in the Browser 
toolbar. Rename the folder.

3 Select the folder, click  to create a new experiment.

An open experiment appears.

4 Rename the experiment.

database icon

open experiment closed experiment
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5 Select the experiment-level cytometer settings, and click the Parameters tab 
in the Inspector.

6 Change, add, or delete parameters as needed.

• To change, select a parameter, and choose a new one from the drop-
down menu.

• To add, click Add—a new line appears. Select it, and choose a 
parameter from the drop-down menu. 

NOTICE     The Add button is enabled only when less than the maximum 
number of parameters are shown in the Inspector.

• To delete, click the selection button next to the parameter and click 
Delete.
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7 In the Acquisition Dashboard, verify the SIT Flush checkbox is selected.

Applying the Setup Results

1 Right-click the experiment-level cytometer settings, and choose Apply 
Setup.

2 Select a setup from the Setup Catalog.

BD FACSCanto clinical software generated a Lyse/No Wash and a Lyse/
Wash setup.

NOTICE     Entries in bolded text are setups created in BD FACSDiva 
software.

3 Click Apply.

BD recommends leaving the SIT Flush option enabled to minimize 
carryover between tubes.

BD FACSDiva setup

BD FACSCanto setup
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Creating Compensation Controls

1 Choose Experiment > Compensation Setup > Create Compensation Controls.

2 (Optional) Edit the labels associated with parameters.

Edit labels when your experiment contains samples stained with the same 
fluorophore conjugated to different antibodies (labels) that require 
different compensation values. Compensation differences are especially 
noticeable in tandem conjugates, due to lot-to-lot variation.

3 Click OK.

The software adds a compensation control, containing stained control tubes 
and one unstained control tube, to your experiment. Normal worksheets 
containing the appropriate plots are added for each compensation tube.
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Optimizing Cytometer Settings

When you performed cytometer QC, voltage settings were adjusted to set each 
parameter at a target value. These settings might not be appropriate for the 
stained sample(s) you plan to analyze. Before recording data, adjust FSC, SSC, 
and threshold settings; gate on the population of interest (such as lymphocytes); 
and adjust voltages to optimize fluorescence signal.

For these adjustments, you will need an unstained control sample. It is important 
to perform these steps in order, as some adjustments influence others.

NOTICE     If the software fails to respond during acquisition and you need to 
restart the software, perform a fluidics startup prior to resuming acquisition. See 
BD FACSDiva Software General Issues on page 215 for more information. 

1 Install the unstained control tube on the cytometer.

• Push the aspirator arm to the left.

• Place the tube onto the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

• Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins.

2 Verify that the green current tube pointer is set to the unstained control 
tube in the Browser. Click .

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.
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If the tube is not fully seated, the following error message appears. Click 
OK. Remove the tube and repeat step 1 to properly reinstall it.

3 Adjust the FSC and SSC voltages to appropriately display the scatter 
properties of the unstained control.

Figure 5-10  Voltages adjusted 

4 Click the Threshold tab and adjust the FSC Threshold, if needed.

Set the threshold to remove most of the debris without cutting off the 
lymphocyte population (Figure 5-10).

5 Adjust the P1 gate on the Unstained Control worksheet to surround only 
the lymphocyte population (Figure 5-10).

Select the gate by clicking on the boundary. Once selected, you can drag the 
gate to move it, or drag any of the selection handles to change the gate 
shape and size.

6 Once the gate is adjusted, right-click its boundary and choose Apply to All 
Compensation Controls.

This applies your gate changes to the P1 gates on the remaining 
compensation worksheets.
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7 Select all fluorescence histograms on the Unstained Control worksheet.

8 In the Plot Inspector, select the Grid checkbox:

Gridlines are used to delineate log decades on plots. In a four-log display, 
values are displayed from 26–262,143. Thus, the first log decade ranges 
from 26–262. The lines are shown only in plots that display log parameters. 

9 Optimize the voltages to place the negative population for each fluorescent 
parameter on scale.

10 Click  to stop acquisition.

11 When acquisition stops, remove the unstained control tube.

• Hold the sample tube while you push the aspirator arm to the left.

• Remove the tube from the SIT.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.

checkbox 
selected
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• Release the aspirator arm.

SIT cleaning occurs when the aspirator arm comes to center.

NOTICE     To prevent backflow into the tube, follow the tube removal 
sequence exactly. For more information, see Cytometer Troubleshooting on 
page 190.

• When the Progress dialog finishes, you can load the next tube onto the 
SIT.

12 Install the stained sample tube on the cytometer and click .

• Push the aspirator arm to the left.

• Place the tube onto the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

• Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins.

13 If necessary, decrease the voltages to place the positive population for each 
fluorescent parameter on scale.

14 Click  to stop acquisition.

15 Remove the stained sample tube.

16 Re-install the unstained sample tube and click .

17 Wait 3 to 5 seconds, then click  to record data for the 
unstained control tube.

Data acquisition stops when acquisition criteria have been met.
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18 When acquisition stops, remove the tube.

Calculating Compensation

For these adjustments, you will need a single-stained control sample for each 
parameter to be measured.

1 Install the first stained control tube onto the cytometer.

2 In the Acquisition Dashboard, click .

This moves the current tube pointer to the next tube in the Browser. 

3 Click .

4 Verify the P1 gate encircles the population of interest, and click Record.

5 When recording is finished, click Remove Tube.

6 Install the next tube onto the SIT.

7 Repeat steps 2 through 6 until data for all stained control tubes has been 
recorded.

Adjusting Gates

1 Make sure the current tube pointer is set next to the first stained control 
(FITC Stained Control) tube.

2 Double-click the FITC Stained Control tube in the Browser to locate the 
corresponding plots on the normal worksheet.

Do not change the PMT voltages after the first compensation tube has been 
recorded. To calculate compensation, all tubes must be recorded with the 
same PMT voltage settings. If you need to adjust the PMT voltage for a 
subsequent compensation tube, delete the current compensation specimen, 
recreate the specimen and run all the compensation tubes again.



88 BD FACSCanto II Instructions for Use

3 If needed, move the P2 gate to encompass the fluorescence-positive 
population.

Figure 5-11  Gating the positive population

4 Make sure the current tube pointer is set to the next stained control tube; 
double-click the tube in the Browser to locate the corresponding plots on 
the normal worksheet.

5 Repeat steps 3 and 4 for the remaining compensation tubes.

Creating a Compensation Matrix

1 Choose Experiment > Compensation Setup > Calculate Compensation.

If the calculation is successful, a dialog appears prompting you for the 
name of the compensation setup.

2 Enter a name for the compensation setup, and select either Link and Save 
to link the setup to the experiment’s cytometer settings, or Apply Only. 
Click OK.

NOTICE     BD Biosciences recommends that you confirm the compensation 
setup by running a process control before you run samples.
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6

Running Samples with
BD FACSCanto Clinical Software

• Running an Acquisition Worklist on page 90

• Reviewing an Analysis Worklist on page 108

• Reviewing a Worklist on page 111

• Logging Out on page 113
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Running an Acquisition Worklist

An acquisition worklist allows you to run a group of samples, optimize 
cytometer settings and save the data, and obtain automated analysis.

When you first open BD FACSCanto clinical software, a blank worklist appears.
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Entering Information into a Worklist

A worklist can contain information for up to 200 samples.

1 (Optional) Enter a name.

2 Enter an ID. 

! Tip     To automatically enter sample IDs, use the optional barcode reader.

3 (Optional) Enter a case number.

4 Choose a panel.

• Either click in the Panel field, click the , and choose a panel, or

• Press Alt-#!to access the Panel menu, and use the arrow keys to choose 
a panel.

For accurate results, make sure you choose the correct panel for your 
sample type.

* * * ** software assigned, not user editable

panel uses Trucount tubes

panel does not use Trucount tubes
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If you select a 4-color TBNK panel that does not use BD Trucount tubes, to 
calculate absolute counts you need to either 

• enter the WBC count (x 1000) and the lymphs (%), or

• enter the absolute lymphocyte count (x 1000)

where .

If you try to enter all three values, the software will alert you with a dialog.

5 (Loader only) Choose a carousel ID in the Carousel field. 

Click the  in the field, and choose a number. The number you choose 
must match the number on top of the carousel.

Running a Process Control

BD Biosciences recommends that you always run a process control using your 
optimized settings before running test samples (unknowns). Process control 
results are automatically exported to a spreadsheet file. Use the file to track 
results over time.

1 In the Name field, enter Control.

Names other than Control (not case-sensitive) will not be exported into the 
control-specific file.

counts cells uL"
1000

-------------------=
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2 In the ID field, enter the control’s lot ID.

Results are exported as [lotID].csv to C:\Program Files\BD FACSCanto 
Software\DataFiles. If the file already exists, results are appended. 

3 (Optional) Enter a case number.

You can also enter a short comment in this field.

4 Select a panel.

5 Run the control as you would a typical sample.

Acquiring Samples

NOTICE     If the software fails to respond during acquisition and you need to 
restart the software, perform a fluidics startup prior to resuming acquisition. See 
BD FACSCanto Software General Issues on page 199 for more information.

1 Enter all sample information into a worklist.

2 (Loader) Prepare to acquire with the Loader.

• Print the worklist; load tubes into the carousel(s) according to the printout.

If the software cannot find a tube when starting a run, a message 
appears requiring operator response. See Figure 6-1 on page 94.

For accurate results, match tube positions to those listed on the 
printout. Make sure to use the carousel rack with the appropriate 
Carousel number. 
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Figure 6-1  Missing Tubes Detected dialog

• Set up the cytometer for automatic loading (page 136).

• Insert the carousel into the Loader, and close the Loader doors.

The worklist will not run with the Loader doors open.

3 Verify that the cytometer is ready.

Check the status bar at the bottom of the main window, and the Status 
window. If an error condition exists, resolve it before starting the worklist.

4 From the View menu, choose to display Detectors, Spectral Overlap, and 
Threshold.

5 Click .

A dialog appears asking if you want to save the worklist:

6 Click ; specify a file name and storage location in the next dialog 
box.

(Loader) The carousel briefly mixes the samples, and acquisition begins.
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7 If no carousel is found, click  to load tubes manually.

 

8 (Manual) When prompted, install the tube containing the first worklist 
sample.

• Push the aspirator arm to the left.

• Place the tube on the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

• Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins.

9 Click .

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.
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If the tube is not fully seated, the following error message appears. Click 
OK. Remove the tube and repeat step 8 to properly reinstall it.

The Acquisition tab comes into view and events appear. See Figure 6-2 on 
page 96.

Figure 6-2  Acquisition tab

10 Observe event data.

Data recording begins as soon as the flow stabilizes. Recording stops 
automatically after the designated acquisition targets have been met.
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After you click  and before data recording begins, choose from the 
following options.

11 View the Lab Report for recorded data.

If the Lab Report countdown is set to On, the Lab Report is shown for the 
designated time. You can pause and edit the report during the countdown. 
See Inspecting Lab Reports on page 101 for instructions.

12 (Loader) Acquisition of the next tube starts automatically.

The Status and FCS File fields update as each sample is recorded.

Table 6-1  Options before recording

To... Do This Additional Information

Optimize detectors, 
thresholds, or spectral 
overlap

1 Click .

2 Click .

See page 100.

Change plot 
parameters

1 Right-click on an 
axis label.

2 Choose a different 
parameter.

Proceed with 
recording

Do nothing.

Stop recording data 
for the worklist

1 Click .

2 Click .

If recording was in progress, 
data for the current tube is 
discarded and no FCS file is 
saved.
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13 (Manual) After data has been recorded for the first tube, remove the tube at 
the prompt and install the next tube.

• Hold your sample tube while you push the aspirator arm to the left.

• Remove the tube from the SIT.

• Release the aspirator arm.

SIT cleaning occurs when the aspirator arm comes to center. When 
cleaning is finished, you are prompted to load the next tube.

NOTICE     If you do not unload a tube when prompted, the following 
message appears.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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If this happens, click , and unload the tube. Wait for the Load 
Tube message before you install the next tube.

NOTICE     To prevent backflow into the tube, follow the tube removal 
sequence exactly. For more information, see Cytometer 
Troubleshooting on page 190. 

14 (Manual) Repeat steps 7 through 11 until there are no more samples.

15 (Loader) Load the next carousel when prompted, and click .

16 After all samples have been run, review the worklist.

17 After the last run of the day, shut down the system.

See Chapter 9 on page 147, for instructions.

Options During Acquisition

Do any of the following during acquisition:

• Adjust voltages, thresholds, and spectral overlap values. See Optimizing 
During a Run (page 100).

• Inspect recorded data on the Lab Report (page 101).

• Skip tubes or samples (page 106).

• Stop recording and acquisition (page 106).

• Add samples to a worklist (page 106).
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Optimizing During a Run

For instructions on using optimization controls, see Using Cytometer Controls on 
page 71.

1 At the Acquisition view, click  on the toolbar to pause.

2 Click .

Live events are displayed without being recorded.

3 Use Detectors controls to adjust detector voltages.

4 Use Thresholds controls to adjust the threshold.

5 Use Spectral Overlap controls to adjust compensation settings. 

6 Click  to return to data recording.

7 Decide how to apply the optimized changes and click the corresponding 
button.

The software applies the updated settings and finishes running the tube 
(unless you click Cancel or Revert to Original).

The software overwrites all events recorded prior to optimizing for the 
current tube.
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Inspecting Lab Reports

To inspect a Lab Report during acquisition, set the Lab Report countdown.

Specifying a Display Time for the Lab Report Countdown 

1 Choose Tools > Options.

2 Click .

3 Select On, time to display countdown (sec).

4 Enter a number of seconds, from 1 to 10, and click .
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If the Lab Report countdown is set, recorded data displays in the Lab Report 
view. A message shows the time remaining to view the report. 

During the countdown, you can pause the run and do any of the following:

• Re-Gating a Plot Manually (below)

• Reapplying the Auto-Gate on page 104

• Re-Running a Tube on page 104

• Verifying Report Review on page 105

Re-Gating a Plot Manually

You can wait until the entire worklist has completed to review plots on the Lab 
Report. However, if you prefer to re-gate plots during a worklist run, follow 
these steps.

1 At the Lab Report Countdown dialog, click Pause.
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2 Click any plot to adjust its gate.

The selected plot appears in an enlarged view:

3 Adjust the gate.

• Select the gate by clicking its boundary.

• Drag the selection handle to adjust the shape or size of the gate.

• Drag the gate boundary between selection handles to move the gate.

Gate changes apply only to the current tube.

4 Click .

selection handle



104 BD FACSCanto II Instructions for Use

Reapplying the Auto-Gate

To override gate changes and return to the automatic gate, click Auto-Gate.

When the confirmation message appears, click .

Re-Running a Tube

After you inspect the data on the Lab Report, you can elect to re-run the tube.

1 Click  at the top of the Lab Report view.

2 Select the tubes you want to re-run, and click .

You can re-run all tubes or a single tube of the current sample:

(
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Verifying Report Review

BD FACSCanto clinical software provides an interface where you can append a 
virtual signature to reviewed reports.

1 Click  at the top of the Lab Report view.

2 Select a reviewer, and click .

• Select Current User for the current, logged-in user.

• Select Other User for a different user. Choose the User ID from the 
menu, and enter a password.

The corresponding worklist Status field changes to Reviewed.
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Skipping a Tube

1 In the Acquisition tab, click .

2 Click .

3 Select whether you want to skip to the Next Tube or Next Sample:

Skipped tubes are indicated on the worklist:

Stopping Recording

To stop recording data for the current sample, click  at the Acquisition tab.

The software saves the data already recorded for that tube and proceeds to the 
Lab Report view or starts acquisition of the next sample.

Adding Samples to the Worklist

You can add samples to a worklist when it is stopped.

1 Click  and then  to stop the worklist.

2 If a sample tube was loaded manually, remove the tube from the SIT.
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3 Enter new sample information into the worklist.

4 Click  to resume.

Importing a Worklist from SPA Software

You can import sample information from a worklist created in BD FACS 
Sample Prep Assistant (SPA) software v2.0 or v3.0.

1 Choose File > Import SPA Worklist.

Sample information can be imported only into a new, blank worklist; you 
cannot add imported information to a worklist that is already started.

2 Navigate to and select a worklist, and click .

By default, SPA worklists are stored in Program Files/BDApps/SPA/
DataFiles on the system where Sample Prep Assistant software is installed. 

! Tip     Create a SPA Worklist folder within the BD FACSCanto Worklists 
folder to help locate files.

3 Review the imported information; edit missing or incorrect entries, if needed.

To import the worklist, all reagent and panel names must exactly match 
those used in BD FACSCanto clinical software. 
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4 If you are running samples with the Loader, verify carousel IDs for each 
sample, and print the worklist.

If carousel IDs are missing or incorrect, choose the correct carousel ID from 
the drop-down menu. Print the worklist, and use it as a guide when you are 
filling the carousels.

Reviewing an Analysis Worklist

An analysis worklist allows you to reanalyze FCS files previously created by 
BD FACSCanto clinical software. Only FCS files created in BD FACSCanto 
clinical software can be processed in an analysis worklist. Do not modify 
BD FACSCanto FCS files with other software applications.

Every time you reanalyze an FCS file, only the latest analysis is saved. 

Creating a New Analysis Worklist

1 Choose File > New Analysis Worklist.

Do not read FCS files created with v2.1 into previous versions of 
BD FACSCanto clinical software. Previous versions will show incorrect 
results.
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2 Add FCS files. 

By default, the software stores FCS files in a dated folder in 
D:\BDFACSCantoFCSFiles.

• To add selected files, click , navigate to the folder containing the 
files, and select them. Click .

Only the FCS file for the first tube in a panel is displayed. All tubes in 
the panel are automatically imported when you select this file.

• To add all files in a folder (including files in subfolders), click , 
locate and select the folder, and click .

3 Verify that the worklist contains all required files.

You cannot edit an analysis worklist.

4 Continue to add FCS files (up to 200).
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Opening an Existing Analysis Worklist

1 Choose File > Open Worklist.

2 Navigate to the folder containing your saved worklists.

By default, worklists are stored in C:\Program Files\BD FACSCanto 
Software\Worklists.

3 From the Files of Type drop-down menu at the bottom of the window, 
choose Analysis Worklists (*.wka).

4 Select an analysis worklist, and click .
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Reviewing a Worklist

After all samples in a worklist have been processed, inspect the Lab Report for 
each sample. You can review Lab Reports after each sample is run, or after an 
acquisition worklist is complete. The following table describes Status entries.

To review a Lab Report, do the following.

1 Double-click the Status field for the sample that needs review.

The Lab Report for that sample appears (Figure 6-3 on page 112).

Status Meaning

Ready To Run All columns filled in and sample ready for acquisition

Not Prepped Sample skipped—prep on SPA II unsuccessful

Running Sample currently being acquired

OK Sample successfully acquired and analyzed with no QC messages

Partial A tube belonging to the sample was successfully acquired or analyzed, 
while another tube was skipped

Incomplete Not all tubes in a multi-tube panel were recorded

Skipped All tubes belonging to the sample were skipped or aborted by user

Needs Review Results out of alarm range, or a QC message appears on the Lab Report

Reviewed Sample marked as reviewed
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Figure 6-3  Lab Report

• To adjust gates, see page 102; to revert to auto-gates, see page 104.

• For suggestions on addressing QC messages, see page 210.

• To append a virtual signature to reviewed reports, see page 105.

2 (Acquisition worklists only) To re-run a tube or all tubes for the sample, 
click  (see Re-Running a Tube on page 104).

Re-running a tube overwrites all data for that tube. You must put the 
sample tube on the SIT to re-run it; you cannot re-run a data file or a 
sample in an analysis worklist.

3 Continue reviewing reports as needed.

Use  to navigate to other Lab Reports in the worklist.

4 Save the worklist.

Saving a worklist allows you to reanalyze data and review Lab Reports at a 
later time and use the worklist as a template.
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Logging Out

To stop using the software without shutting down the flow cytometer, click  
to log out. 

The next user can now log in.
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Running Samples with
BD FACSDiva Software

This section describes how to use BD FACSDiva software features to record and 
analyze sample data. As an example, data will be recorded and analyzed for two 
tubes of human peripheral blood stained with the following reagents: 

• CD45 FITC

• CD16+CD56 PE

• CD8 PerCP-Cy5.5

• CD19 PE-Cy7

• CD3 APC

• CD4 APC-Cy7

For other analysis methods, refer to the information supplied with the reagent.
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Setting Up the Global Worksheet

This section shows you how to use a global worksheet to preview and record 
data for multiple samples. To switch between the normal and global worksheet 
view, click the Global Worksheets button on the Worksheet toolbar ( ).

1 Open the experiment in which you optimized cytometer settings.

2 Create a new specimen ( ); rename it LWB.

3 Create two tubes under the LWB specimen, and rename them.

For example, TBNK_001 and TBNK_002.

To create a second tube, select the specimen, and click ( ).

4 Create a global worksheet; rename it Record Data.

• If the Default global worksheet preference is enabled in User 
Preferences (default option), the global worksheet is already present. 
Expand the Global Worksheets folder to locate and rename the 
worksheet.

• If the Default global worksheet preference is disabled, create a global 
worksheet by clicking the New Global Worksheet button in the 
Browser toolbar ( ).

5 Use the Experiment Layout dialog to define parameter labels and to specify 
the number of events to record for each tube.

Labels will appear on the plot axes and in all statistics views.

• Choose Experiment > Experiment Layout.

BD FACSDiva software v5.0 is required to run the BD FACSCanto II flow 
cytometer. Older versions of BD FACSDiva software will not work with a 
BD FACSCanto II flow cytometer.
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• In the Labels tab, enter appropriate labels for the tube. For example, 
enter CD45 in the FITC field. Use the Tab key to move to the next field 
(Figure 7-1).

Figure 7-1  Entering parameter labels

• In the Acquisition tab, verify 10,000 events to record for tubes 
TBNK_001 and TBNK_002; click OK.

6 On the global worksheet, create plots for previewing the data.

For example, create FITC vs SSC, APC vs PE-Cy7, APC vs PE, APC vs 
APC-Cy7, and APC vs PerCP-Cy5.5 dot plots.
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Recording Data

If you want to save a copy of the data displayed in the global worksheet with 
each recorded tube, enable the Save analysis after recording through global 
worksheet preference in the User Preferences window (Figure 5-9 on page 78). If 
you do not want to save a copy of the data, leave the preference disabled.

NOTICE     If the software fails to respond during acquisition and you need to 
restart the software, perform a fluidics startup prior to resuming acquisition. See 
BD FACSDiva Software General Issues on page 215 for more information. 

1 Install the first sample tube onto the cytometer.

• Push the aspirator arm to the left.

• Place the tube on the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

• Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins.

2 In Acquisition Setup (Figure 7-2 on page 119), verify that you are using an 
appropriate flow rate and that the SIT Flush checkbox is selected.

! Tip     Hide or show acquisition setup information by right-clicking the 
dashboard anywhere outside the Basic Controls area and selecting the 
option from the menu.

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.

BD recommends leaving the SIT Flush option enabled to minimize 
carryover between tubes.
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Figure 7-2  Acquisition Dashboard showing Acquisition Setup

• Low = approximately 10 #L/min of sample

• Medium = approximately 60 #L/min of sample

• High = approximately 120 #L/min of sample

3 Move the current tube pointer to the first tube. Click .

If the tube is not fully seated, the following error message appears. Click 
OK. Remove the tube and repeat step 1 to properly reinstall it.

4 While data is being acquired, draw a gate around the lymphocytes; set the 
other plots to show data from the lymphocyte population.

5 Click .
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6 When all events have been recorded, click  and unload the 
sample tube when the aspirator arm lowers.

• When the aspirator arm lowers, hold your sample tube while you push 
the aspirator arm to the left.

• Remove the tube from the SIT.

• Release the aspirator arm.

SIT cleaning occurs when the aspirator arm comes to center.

NOTICE     If the tube is not removed within approximately30 seconds, the 
aspirator arm will lock against the tube. You will be prompted to either 
continue acquiring or remove the tube.

7 When the SIT flush is complete, load the next tube.

8 Click , and then .

9 Preview the data in the global worksheet. Click .

10 Repeat steps 6 through 9 until data has been recorded for all tubes.

11 (Optional) To print the experiment-level cytometer settings or the 
Cytometer Status report, right-click the cytometer settings icon and choose 
Print.

Importing a Worklist from SPA Software

You can import sample information from a worklist created in 
BD FACS Sample Prep Assistant (SPA) software v2.0 or v3.0.

1 (Optional) In Sample Prep Assistant software, print a report of the worklist 
you want to import into BD FACSDiva software.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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2 Verify tube and panel names from the SPA worklist exactly match those in 
the BD FACSDiva panel template.

3 If there is a discrepancy, create a new panel template in BD FACSDiva 
software to match the reagent panel in the SPA software; otherwise, go to 
step 4.

4 Choose File > Import > Worklist.

5 Navigate to and select a worklist, and click .

By default, SPA worklists are stored in Program Files/BDApps/SPA/
DataFiles on the system where Sample Prep Assistant software is installed.

BD FACSDiva software creates a locked experiment that includes all 
specimens prepared in the SPA worklist.

To import the worklist, all tube names in the panel template and the panel 
template name in BD FACSDiva software must exactly match the tube 
names and reagent panel name used to prepare samples in the SPA 
software. 
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Analyzing Data

1 Create a new global worksheet; rename it TBNK Analysis.

2 Select the first tube under the LWB specimen and create the following dot 
plots: FITC vs SSC, APC vs PE-Cy7, APC vs PE, APC vs APC-Cy7, and 
APC vs PerCP-Cy5.5.

3 Resize the plots so they fit on one page.

! Tip     By default, the plots will fit on one page if you select three across.

4 On the FITC vs SSC plot, draw a gate around the lymphocytes; use the 
Population Hierarchy to rename the population Lymphocytes.

5 Select all plots except the FITC vs SSC plot and specify to show only the 
Lymphocyte population.

Hold down the Control key while you select successive plots. Once all plots 
are selected, click the checkbox next to Lymphocytes in the Plot Inspector. 

6 Select all plots and click the Title tab in the Plot Inspector; select the 
checkboxes to display the tube and specimen names in the plot titles.
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7 Create a statistics view; edit the view to show the Lymphocyte population 
and subpopulations, and to display the mean for all fluorochromes.

To create a statistics view, right-click any plot and choose Create Statistics 
View. The resulting statistics view lists the number of events, %Parent, and 
means of the plot parameters for all populations displayed in the plot.

8 Draw a gate around the CD19 positive population on the CD3 APC vs 
CD19 PE-Cy7 plot; name the population B Cells.

9 Draw a gate around the CD16+56–positive population on the CD3 APC vs 
CD16+56 PE plot; name the population NK Cells.

10 Draw a gate around the double-positive population on the CD3 APC vs 
CD4 APC-Cy7 plot, and name the population T Helper.

11 Draw a gate around the double-positive population on the CD3 APC vs 
CD8 PerCP-Cy5-5 plot; name the population T Cytotoxic.
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12 Print the analysis.

Figure 7-3  Lymphocyte analysis (example)
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Reusing the Analysis

Now that the analysis strategy has been defined, use it to analyze the remaining 
tubes in the experiment. Global worksheets allow you to apply an analysis 
strategy to a series of data files without saving the analysis each time. After 
previewing the data, you can print the analysis or save it to a tube-specific 
(normal) worksheet (see the following section, Saving the Analysis).

1 Move the current tube pointer to the next tube under the LWB specimen.

2 View the data on the global worksheet; make adjustments to gates, as 
needed.

Adjustments will also apply to the next tube viewed on the global 
worksheet. If you don’t want to alter the global worksheet, save the 
analysis as described in the next section and make adjustments on the 
tube’s normal worksheet.

Saving the Analysis

Since the analysis objects were created on a global worksheet, the analysis will 
not be saved with each tube. If you want to save a copy of the analysis with any 
tube, do the following.

1 Expand the TBNK Analysis global worksheet in the Browser.

2 On the Worksheet toolbar, click the Global Worksheets button ( ) to 
switch to the normal worksheet view.

3 Create a new normal worksheet for the destination tube; rename the 
worksheet.
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4 In the Browser, right-click the analysis object below the global worksheet 
icon and choose Copy.

5 Select the tube in the Browser; right-click the tube icon and choose Paste.

The elements on the global worksheet are copied to the new normal 
worksheet. View the analysis by double-clicking the tube in the Browser.

! Tip     Automatically save a copy of the analysis with each tube by enabling the 
Save Analysis After Recording preference before you record data. In this case, the 
analysis plots are placed on the normal worksheet that is open at the time of 
recording. To control where the plots are placed, create a new normal (tube-
specific) worksheet before data is recorded.

analysis object
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Logging Out

Log out when you are finished using BD FACSDiva software, but not ready to 
shut down the system.

1 Choose File > Log Out.

2 If the system will be used to run samples after you log out, select Log out 
only.

NOTICE     If you select Log out after a fluidics shutdown, keep in mind 
fluidics shutdown can take up to 5 minutes to complete.

The BD FACSDiva workspace is hidden and the Log In dialog appears. The 
system is available for the next operator to log in.
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Using the Loader with
BD FACSDiva Software

• Getting Ready on page 130

• Assigning Carousels and Verifying Run Settings on page 132

• Preparing the Loader on page 136

• Running Samples on page 139

• Running Cleaning Tubes on the Loader on page 146
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Getting Ready

1 Start up the cytometer, workstation, and software.

2 Perform cytometer quality control and sample optimization.

3 (Optional) Open a new experiment, and copy your optimized cytometer 
settings from step 2 to the new experiment.

Alternatively, you can also add specimens to the experiment used during 
sample optimization (step 4).

NOTICE     You must use a global worksheet for data display when acquiring 
samples with the Loader.

4 Add specimens and tubes to your experiment (see Figure 8-1 on page 131).

To add a predefined panel:

• Select any Browser item within the open experiment, and choose 
Experiment > New Specimen. 

• Click the BD Panels tab and select a panel.

• Specify the number of copies (each copy creates a new specimen in the 
Browser), and click OK.
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Figure 8-1  Panel Templates dialog

5 If you imported panels, inspect the information and the cytometer settings 
for each panel type to make sure they are complete and appropriate.
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Assigning Carousels and Verifying Run Settings

1 Choose Edit > User Preferences > Carousel tab > General tab, and make 
selections for printing and pausing.

reviewing options

printing options

error handling options
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2 Select how you want the Loader to handle any tube pressurization errors 
that occur during the run.

If a tube or specimen is skipped during the run, this will be highlighted in 
the Carousel Report.

NOTICE     To make changes to the Tube Pressurization Error Handling 
options for the current run only, use the Carousel Setup window. See 
Figure 8-2 on page 134.

3 Click the Carousel tab > Save Options tab, and choose whether and where 
to automatically save the statistics results and Carousel Report.

4 Click OK to save changes.

Tube Pressurization 
Error Handling Options Function

Show error and wait Stops the run and waits for you to choose 
whether to abort the run, skip the tube, or skip 
to the next specimen

Skip to next tube Automatically moves to the next tube if an error 
is encountered

Skip to next specimen Automatically moves to the next specimen if an 
error is encountered 
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NOTICE     Options chosen in the User Preferences dialog are applied 
globally.

5 Choose Carousel > Carousel Setup.

All specimens or panels in the experiment are listed at the top of the 
Carousel Setup window. This is your worklist. Carousel locations are 
automatically assigned. You will need to assign a carousel ID to each 
specimen (see step 7).

Figure 8-2  Carousel Setup window

You can choose to export the FCS data from a carousel run. Click the 
folder in the Export Folder column and choose a directory. 
C:\BDExport\FCS is the default folder.

worklist

run settings 
options

error handling 
options
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6 (Optional) Insert or delete carousel breaks.

Carousel breaks, represented by a thick horizontal line, indicate the start of 
a new carousel. The software automatically inserts them whenever a 
carousel cannot contain the next specimen’s tubes. To change carousel 
assignments for tubes, insert and delete breaks.

You can insert or delete breaks only on an unassigned carousel (carousel ID 
is None).

• To insert, select a row, click New Carousel, and select an ID number 
from the drop-down list.

• To delete, select None from the Carousel ID drop-down list, select the 
break line, and click Delete Carousel Break.

7 From the menu, assign a carousel ID to each specimen.

8 Click Print to print a record of tube and carousel assignments, as well as 
the FCS directory selected for each specimen.

Use the printout as a guide when filling the carousels.

9 Verify the Run Settings.

drop-down list
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See Figure 8-2 on page 134.

Preparing the Loader

1 Set up the cytometer for automatic loading. 

Figure 8-3  Automatic loading

Run Settings Options Range Function

Acquisition time 3–15 seconds Allows acquisition to stabilize 
before recording begins

Start of carousel mix Performs 10-second mix 
when run begins

Interim mix After every 1–20 
tubes

Performs a mix after a 
specified number of tubes

Mix duration 3–25 seconds Allows you to set the 
duration of the interim mix

aspirator arm bar horizontal

tube guide forward
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2 Gently remove the carousel from the cytometer as shown:

3 Vortex the sample tubes and place them uncapped in the carousel(s) 
according to the worklist.

4 Install the first carousel to be acquired on the Loader.

Position the spindle hole in the handle over the center spindle of the Loader 
drawer. Rotate the carousel until the alignment guide pin fits into the small 
alignment hole at the top of the carousel. Press down firmly to seat the 
carousel.

For accurate results, match the tubes to those listed on the printed worklist 
(BD FACSCanto clinical software) or Carousel Setup (BD FACSDiva 
software). Print out a copy of tube assignments and use the printout as a 
guide when filling each carousel. 

To prevent binding during loading, make sure label thickness per tube is 
less than three labels. Flatten labels completely before placing a tube in the 
carousel.
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Figure 8-4  Installing the carousel

5 Close the Loader drawer completely, and close the Loader doors.

The Loader scans and positions the carousel at tube 1.

To run the Loader, the doors must be closed. Tubes will not load with the 
doors open. The currently running tube will be unloaded if you open the 
doors during a run. 

spindle

handle

alignment pin

Loader doors (closed)
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Running Samples 

NOTICE     If the software fails to respond during acquisition and you need to 
restart the software, perform a fluidics startup prior to resuming acquisition. See 
BD FACSDiva Software General Issues on page 215 for more information.

1 To activate the acquisition controls, select the first tube in your experiment 
with the current tube pointer.

2 In Acquisition Setup (Figure 8-5):

• Verify that you are using an appropriate flow rate.

• Enter a stopping time (seconds).

Figure 8-5  Acquisition Setup in Acquisition Dashboard

If the stopping time is 0, the software uses a default stopping gate 
based on number of events. When you enter a time, the software stops 
either when it reaches the total number of events, or when it reaches 
the time limit, whichever comes first.

! Tip     BD Biosciences recommends that you always enter a stopping time. 
Setting a time limit ensures that the carousel doesn’t stall on one tube if that 
tube should contain a dilute sample or rare events.

3 In Carousel Controls, click .

current tube pointer
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4 View data for the first tube on the global worksheet. 

The ID of the currently running carousel along with the tube’s position 
appear in Carousel Controls. 

5 If necessary, click Pause and make adjustments to cytometer settings or the 
analysis. 

6 Click Resume to proceed with acquisition of the next tube. 

Data for the current tube is displayed in the global worksheet view for the 
amount of time specified in General Carousel preferences. Any changes to 
the global worksheet remain in effect for the rest of the tubes that use the 
same worksheet.

Tube processing continues until the carousel is complete. Repeat step 4 
through step 6 for the remaining tubes on the carousel.

7 Load the next carousel when prompted; click Continue.

8 When done, review the Carousel Run Report (Figure 8-6 on page 141).

Any tube errors that occurred during the run are highlighted.
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Figure 8-6  Example Carousel Run Report

The report prints automatically if specified in the General tab of the 
Carousel tab under the User Preferences. If you selected the automatic 
saving preference in the Save Options tab of the Carousel tab, the report is 
saved to the designated directory. You can also save the report as a PDF or 
export it.

Skipping or Re-Running Samples

When you re-run a sample, existing data is not overwritten. 

• If the Export FCS after recording preference is enabled, a new FCS file is 
saved as: <Specimen Name>_<TubeName>_<DDMMYYYYHHMMSS>.fcs, 
where DDMMYYYY represents the date and HHMMSS represents the time 
the new file was saved.

• If the Automatic Saving... preference is enabled for statistics results, a new 
row is written to the statistics results file. 
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Skipping or Re-running Tubes or Specimens During a Run

To skip a tube or specimen:

1 Click  in Carousel Controls. 

2 In the dialog that appears, choose tube or specimen.

The carousel moves to the next tube or specimen.

To re-run a tube or specimen:

1 Click  in Carousel Controls.

2 In the dialog that appears, choose either tube or specimen.

The carousel moves to re-run the selected tube or specimen.
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Re-running Tubes or Specimens After Acquisition

1 Choose Carousel > Carousel Setup.

2 In the worklist, change the Carousel ID to None for all specimens that you 
want to re-run.

3 Click New Carousel and reassign the carousel rack; click OK to close the 
window.

4 Click Run Carousel in Carousel Controls.

5 In the re-run dialog that appears, select the tubes or specimens you want to 
re-run; click OK to close the dialog.
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Adding Tubes to an Existing Carousel

1 In the current experiment, add a specimen.

2 Choose Carousel > Carousel Setup.

3 Delete the Carousel break.

The Carousel ID is automatically assigned to the new specimen in the 
worklist.

4 Click Run Carousel in Carousel Controls.

5 In the re-run dialog that appears, select the new tubes or specimen; click 
OK to close the dialog.

Re-running a Carousel

1 After all tubes in the carousel are recorded, click Run Carousel in Carousel 
Controls.

2 In the dialog that appears, select all tubes in the carousel; click OK to close 
the dialog.

The run begins.

Stopping a Run

To stop a carousel, click  in Carousel Controls. The run stops and 
the Carousel Report appears.
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Running a Single Tube

1 To run a single tube using the carousel, click  in Carousel 
Controls.

2 In the dialog that appears, select the tube you want to run; click OK to 
close the dialog and begin the run.

See Figure 8-7 on page 145.

Figure 8-7  Single Tube Loader dialog

3 When the tube is finished, click  in the Acquisition Dashboard.
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Running Cleaning Tubes on the Loader

1 In Acquisition Setup, check flow rate; set to Medium.

2 Choose Carousel > Clean; select the tube type and number of minutes to 
run each tube.

3 Click OK.

4 Move the current tube pointer to the first cleaning tube.

5 Place tubes filled with the appropriate solution in the designated positions 
in the cleaning rack.

BD recommends using at least BD FACSClean solution and DI water.

6 Click OK to begin cleaning.
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Shutting Down

At the end of the day, shut down the cytometer.

BD FACSCanto Clinical Software

1 Create a worklist.

• Enter Clean as the Sample ID.

• Choose a two-tube panel (such as 4 color TBNK) from the panel field 
menu.

2 Click .

3 When prompted to save the worklist, click No.

4 (Loader Only) Click  to run tubes manually.

Each panel has default acquisition targets. A lab manager should set the 
time target (Max time for acquisition) for the two-tube panel to be used for 
the Clean to no less than 300 seconds (5 minutes).
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5 When prompted, install a tube with $3 mL of BD FACSClean solution or 
10% bleach on the SIT. Firmly push up on the tube until it comes to a 
complete stop and is fully seated.

6 Click .

7 After 5 minutes, click .

Do not click .

8 When prompted, unload the tube.

9 Install a tube with $3 mL of DI water. Firmly push up on the tube until it 
comes to a complete stop and is fully seated.

10 Repeat steps 6 through 8.

11 Choose File > Exit, and select Run fluidics shutdown and exit.

BD Biosciences recommends turning off the cytometer when not in use to 
preserve laser life.

NOTICE     After every 4 hours of operation, and during cytometer 
shutdown, you will hear a hiss when condensed water discharges from the 
fluidics cart pumps into the condensation trap.

12 When fluidics shutdown completes, the software closes.

13 Turn off cytometer power.

To prevent fluid overflow, do not leave a tube on the SIT during fluidics 
shutdown.
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14 Shut down the computer.

15 Wet a soft, lint-free cloth with DI water and wipe down the following 
surfaces daily to prevent salt buildup:

• SIT 

Be careful not to bend the SIT.

• aspirator arm

Wipe all exposed surfaces of the aspirator arm that are outside the 
cytometer chassis.

16 Use a dry lint-free cloth to remove residual moisture.

! Tip     Place an empty tube on the SIT to catch any BD shutdown solution 
that might drip from the SIT.

17 Empty the condensation trap located underneath the fluidics cart power 
panel. See Figure 1-6 on page 22.

BD FACSDiva Software

Use this procedure when cleaning the cytometer manually (without the Loader). 
Use the procedure, Running Cleaning Tubes on the Loader on page 146, when 
the Loader is installed.

1 Install a tube with $3 mL of BD FACSClean solution or 10% bleach on the 
SIT. Firmly push up on the tube until it comes to a complete stop.

2 In Acquisition Setup, set stopping time to 300 sec (5 min).
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3 In Basic Controls, click Acquire Data.

4 After 300 sec (5 min), click  and remove the tube.

5 Install a tube with $3 mL of DI water on the SIT. Firmly push up on the 
tube until it comes to a complete stop and is fully seated.

6 Repeat steps 3 and 4.

7 Choose Cytometer > Fluidics Shutdown, and then follow all prompts.

8 Turn off cytometer power.

BD Biosciences recommends turning off the cytometer when not in use to 
preserve laser life.

NOTICE     After every 4 hours of operation, and during cytometer 
shutdown, you will hear a hiss as condensed water discharges from the 
fluidics cart pumps into the condensation trap.

9 Quit BD FACSDiva software.

The following dialog appears. Verify Exit application only is selected and 
click OK.

To prevent fluid overflow, do not leave a tube on the SIT during fluidics 
shutdown.
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10 Shut down the computer.

11 Wet a soft, lint-free cloth with DI water and gently wipe down the 
following surfaces daily to remove salt buildup:

• SIT 

Be careful not to bend the SIT.

• aspirator arm

Wipe all exposed surfaces of the aspirator arm that are outside the 
cytometer chassis.

12 Use a dry lint-free cloth to remove residual moisture.

! Tip     Place an empty tube on the SIT to catch any BD shutdown solution 
that might drip from the SIT.

13 Empty the condensation trap located underneath the fluidics cart power 
panel. See Figure 1-6 on page 22.
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10

Maintenance

• Scheduled Maintenance on page 154

• Unscheduled Maintenance on page 164
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Scheduled Maintenance

For optimal cytometer functioning, perform the following maintenance 
according to the recommended schedule.

Procedure Description and Location Frequency

Fluidics startup Replaces BD FACS shutdown 
solution with BD FACSFlow 
solution

See step 5 on page 47.

Daily

Fluidics shutdown Replaces BD FACSFlow 
solution with BD FACS 
shutdown solution

See Shutting Down on 
page 147.

Daily

Empty the waste See Emptying the Waste 
Container on page 156.

Daily and as needed

Wipe down SIT and 
aspirator arm

Prevents saline deposit buildup

See step 15 on page 149 and 
step 11 on page 151.

Daily

Empty condensation trap 
on the fluidics cart

Prevents overflow of 
condensation trap

See step 17 on page 149 and 
step 13 on page 151.

Daily

Purge fluid filters Removes air from fluid filters, 
ensuring they will not dry out

See Purging the Fluidics Filters 
on page 158.

Weekly

Change waste container 
cap

See step 6 on page 158. Monthly
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Decontaminate fluidics 
(Long Clean)

Decontaminates the internal 
sheath path with 
BD FACSClean solution, then 
rinses with BD FACS shutdown 
solution

See page 160.

Monthly and before 
service calls

Replace air filter Ensures proper cytometer 
performance

See Replacing the Air Filter on 
page 161.

Every 6 months

Replace fluid filters Keeps fluids free of particulates

See Replacing Fluidics Filters on 
page 162.

Every 6 months or when 
increased debris observed 
in FSC vs SSC plots

Schedule preventative 
maintenance by BD 
service

— Every 6 months

Procedure Description and Location Frequency
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Emptying the Waste Container

Figure 10-1  Location of waste port on fluidics cart

1 Ensure the cytometer is not acquiring events.

2 Detach the waste container’s sensor line and fluid line from the fluidics cart 
waste port (Figure 10-2 on page 157).

• Pull the sensor straight out.

• Press the metal clip on the fluid line.

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total volume) 
before disposal. Dispose of waste in accordance with local regulations. Use 
proper precautions and wear suitable protective clothing, eyewear, and 
gloves.

disposable 
waste cap

trap

waste
container

waste port



Chapter 10: Maintenance 157

Figure 10-2  Closeup of waste port

3 Remove the disposable waste cap and 
attached trap from the container; place the 
assembly on the bench label-side up.  

4 Empty the bleach-exposed waste.

The waste container can become pressurized when the cytometer is 
running. Always disconnect the container from the fluidics cart before you 
empty it. Wait at least 30 seconds for pressure to dissipate before you 
remove the waste cap or level sensor cap.

Do not wet the cap. If you see liquid inside 
the trap, treat it as biohazardous waste. 
Remove the drain plug and fully drain the 
liquid. Rinse the trap and drain plug with 
10% bleach, followed by DI water. Replace 
the drain plug.

sensor
waste fluid line 
with metal clip

drain plug

trap
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5 Add approximately 1 L of bleach to the empty waste container (10 L 
container).

6 If one month has passed since the last cap change:

• Detach the cap from the trap.

• Replace it with a new cap.

• Write the date on the cap label.

7 Screw the cap assembly onto the waste container and hand-tighten until it 
is fully closed.

8 Re-attach the sensor line and fluid line.

Purging the Fluidics Filters

NOTICE     The cytometer must be on (system pressurized) during this procedure.

1 Run the Prime After Tank Refill for all fluids to ensure all fluid lines are 
primed.

See Priming Fluidics Lines on page 169.

2 Place a few paper towels beneath the filter to be purged.

To prevent waste container overpressurization, do not overtighten the trap 
or attached filter cap. Tighten each component only until it is hand-tight. 
Do not use sealants such as Teflon® tape or other adhesives.

338677 Rev A

Waste (A)

space for date
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3 Loosen the bleeder valve near the top of the filter by turning it 
counterclockwise.

NOTICE     Do not loosen the bottom bleeder valve. Ensure it is tightened.

! Tip     Do not completely unscrew the valve. If you do, it will come off.

4 Wait until fluid seeps out.

Fluid should seep from the open valve within 30 seconds. If no fluid 
appears, make sure the corresponding cubitainer is not empty or detached 
from the cart. If the cubitainer contains fluid and the fluid lines are 
attached and primed, the filter might be airlocked. See Removing an Air 
Lock on page 169.

5 Close the valve by turning it clockwise.

6 Repeat steps 2 through 5 with the remaining filters.

loosen this 
bleeder valve

DO NOT loosen this 
bleeder valve
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Decontaminating the Fluidics System (Long Clean)

NOTICE     This procedure takes about 75 minutes to complete.

1 Check all fluid levels. Empty the waste if needed.

2 Select Cytometer > Cleaning Modes > Long Clean.

A confirmation dialog is displayed. 

3 Click OK to continue. Once you have begun the Long Clean, you cannot 
abort the process.

4 Click OK when the completion message appears.

5 Choose to shut down or continue.

• To shut down, quit the software and turn off the power to the 
cytometer.

• To continue, choose Cytometer > Fluidics Startup.

! Tip     If setup fails after a long clean, repeat Fluidics Startup until setup 
passes.

The Cytometer menu in BD FACSCanto clinical software differs slightly 
from the BD FACSDiva Cytometer menu. Instructions in this and the 
following sections list the BD FACSCanto menu first, followed by the 
BD FACSDiva menu, in parentheses.

If the completion message has not appeared after 90 minutes, verify that 
there are no error messages in the Status tab of the Cytometer window. If 
the cleaning mode fails, see Fluidics Cart Troubleshooting on page 198.
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Replacing the Air Filter

1 Turn off the cytometer power.

2 On the cytometer, open the right side door by pressing the black button, 
and then twisting and pulling the handle that pops out.

3 On the door’s interior, turn the tabs located along the upper edge of the 
filter to release the old filter.

Dispose of the old filter. It cannot be reused.

4 Install a new filter. Ensure that the arrows etched on edges of the new filter 
point in toward the cytometer.



162 BD FACSCanto II Instructions for Use

5 Turn the tabs to hold the filter.

6 Close the side door.

Replacing Fluidics Filters

The fluidics cart should be on during this procedure.

Change the fluid filters when you see increased debris in FSC vs SSC plots, or 
every 6 months.

1 Place a few paper towels beneath the filter.

2 Remove the filter by pressing the metal tabs on each quick-disconnect 
coupling.

See Figure 10-3 on page 163.

To avoid cytometer damage, do not close the door on any tubing or wires. 
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Figure 10-3  Removing the filter

3 Position the new filter and connect the couplings.

! Tip     Write today’s date on the filter so you will know when to replace it.

4 Loosen the top bleeder valve by turning it counterclockwise.

NOTICE     Do not loosen the bottom bleeder valve. Ensure it is tightened.

5 Wait until fluid seeps out.

Fluid should seep from the open valve within 30 seconds. If no fluid 
appears, ensure the corresponding cubitainer is not empty or detached from 
the cart. If the cubitainer contains fluid and the fluid lines are attached and 
primed, the filter might be airlocked. See Removing an Air Lock on 
page 169.

6 Close the valve by turning it clockwise.

Repeat the procedure for other fluid filters to be replaced.

quick-disconnect
coupling

metal tab

metal tab

loosen this 
bleeder valve

FLOW
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Unscheduled Maintenance

Perform these maintenance procedures as indicated in the table.

Procedure Description and Location When to Perform

Replace cubitainers See Changing a Cubitainer on 
page 166.

As needed

Prime fluid lines Removes air from fluid lines

See Priming Fluidics Lines on 
page 169.

Whenever a fluidics line 
is disconnected to change 
a cubitainer or perform 
other maintenance

Remove an air lock Removes air from filter and 
restores flow of fluid

See Removing an Air Lock on 
page 169.

When fluidics are not 
functioning properly 
(flow cell will not fill, or 
there is backflush into 
sample tube)

Clean external surfaces Keeps surfaces free from salt 
buildup after exposure to sheath 
fluid

See Cleaning External Surfaces 
on page 171.

As needed

De-gas Flow Cell Removes bubbles from the flow 
cell

See See Removing Bubbles from 
the Flow Cell on page 172.

As needed during daily 
startup

Clean Flow Cell Runs BD FACSClean solution 
through the SIT and flow cell

See Cleaning the Flow Cell on 
page 173.

When poor optical 
performance indicates 
additional cleaning is 
needed

Bubble Filter Purge Removes air from the bubble 
filter

See Purging the Bubble Filter on 
page 174.

If fluidics run dry, or 
when CVs are poor
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Decontaminate the 
fluidics system for 
storage

Cleans out the fluidics lines with 
BD FACSClean solution, then 
fills them with BD FACS 
shutdown solution

See Decontaminating the 
Fluidics System for Storage on 
page 175.

Before long-term storage

Replace the Bal seal Replaces worn Bal seal 

See Replacing the Bal Seal on 
page 175.

When the seal becomes 
worn or cracked (sample 
tubes will not pressurize)

Reconnect fluidics cart 
tubing

See Reconnecting the Fluidics 
Cart Tubing on page 181.

As needed

Replace fluidics level 
sensors

See Replacing the Fluidics Level 
Sensors on page 183.

When instructed to by a 
BD Biosciences service 
representative

Replace fluidics cart fuses See Replacing the Fluidics Cart 
Fuses on page 186.

When cart will not 
function because of power 
surge or other electrical 
event

Procedure Description and Location When to Perform
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Changing a Cubitainer

Three fluidics cubitainers (disposable boxes of approved fluids) and a waste 
container fit onto the cart in the following configuration:

Each cubitainer and the waste container has its own color-coded port. 

1 Ensure the cytometer is not acquiring events.

2 Detach the sensor and fluid line from the cart.

BD FACS shutdown solution

waste container

BD FACSClean solution

BD FACSFlow solution
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• Pull the sensor straight out.

• Press the metal clip on the fluid line.

3 Unscrew the cap on the cubitainer.

You could damage the sensor line if you leave it connected while changing a 
cubitainer. 

sensor

metal clip
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4 Remove the cap and sensor assembly and set it aside.

I

5 Put a new cubitainer onto the fluidics cart.

6 Replace the cap assembly and hand-tighten it until it is fully closed.

7 Reattach the sensor line and fluid line to the cart.

• To attach the sensor line, gently rotate until the connection aligns, and 
then push.

• To attach the fluid line, push the coupling into the port until it clicks.

8 Prime the fluidics.

Important: Continue with the procedure in Priming Fluidics Lines on 
page 169.

To ensure that the appropriate solutions are dispensed, match the label on 
the container to the port on the fluidics cart. 
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Priming Fluidics Lines

1 Choose Cytometer > Cleaning Modes > Prime After Tank Refill.

2 Select the checkboxes for the cubitainers you changed; click OK.

3 Click OK when the completion message displays. 

NOTICE     If the fluidics are not functioning properly, perform Removing an 
Air Lock.

Removing an Air Lock 

1 Place a few paper towels beneath the air-locked filter.

2 Remove the filter by pressing the metal tabs.

Figure 10-4  Fluidics filter

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

metal tab

metal tab
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3 Install bypass tubing in place of the filter.

4 Choose Cytometer > Cleaning Modes > Prime After Tank Refill.

5 Select the checkbox that corresponds to the filter you have bypassed.

6 Click OK.

7 Ensure fluid is moving through the bypass tubing.

8 When the prime finishes, remove the bypass tubing.

9 Reattach the filter to the fluidics cart.

bypass tubing, 
installed

BD FACSDiva softwareBD FACSCanto clinical software
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10 Repeat the Prime After Tank Refill command.

11 Open the bleeder valve and wait for fluid to seep out. Close the valve.

If no fluid seeps out, repeat steps 10 and 11.

Figure 10-5  Bleeder valves on fluidics filter

Cleaning External Surfaces

To prevent saline deposit buildup, wipe down all external cytometer surfaces that 
have been exposed to sheath fluid. 

NOTICE     Over time, saline deposits may develop on the interior surface of the 
SIT Bal seal retainer, causing an incomplete SIT flush between samples. If this 
occurs, you might need to remove and clean the retainer with DI water. See 
Figure 10-6 on page 175 and steps 3, 4, 9, and 10 of the Replacing the Bal Seal 
procedure that starts on page 175.

NOTICE     Do not use BD FACSClean solution or bleach to clean or disinfect the 
barcode reader. See Cleaning the Barcode Reader on page 42.

loosen this 
bleeder valve

DO NOT loosen this 
bleeder valve
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1 Switch off the cytometer power and unplug the AC power cord.

2 Wipe all accessible surfaces with BD FACSClean solution.

3 Wet a fresh cloth with DI water and wipe all bleach-exposed surfaces to 
prevent corrosion.

4 Wipe all exposed surfaces with a clean, dry cloth.

Removing Bubbles from the Flow Cell

1 Select Cytometer > Cleaning Modes > De-gas Flow Cell.

2 Click OK when the completion message displays.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

To prevent damage, do not use isopropyl alcohol or ethanol on any 
cytometer or fluidics cart surface. 

To avoid potential shock, always switch off the power and unplug the AC 
power cord before you begin cleaning.

BD FACSCanto clinical software BD FACSDiva software
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3 Check the flow cell for bubbles.

If you still see bubbles, repeat the process.

! Tip     You might need to de-gas a new flow cell several times to clear bubbles.

Cleaning the Flow Cell

1 Choose Cytometer > Cleaning Modes > Clean Flow Cell.

2 If you have a Loader installed, remove the carousel.

3 When prompted, manually install a tube containing approximately 2 mL of 
cleaning solution onto the SIT, and click OK.

A progress message is displayed during the cleaning.

4 After the completion message displays, wait 5 minutes. 

Waiting allows BD FACSClean solution to dissolve deposits in the flow cell 
cuvette.

5 Click OK.

6 Remove the tube from the SIT.

7 Clear BD FACSClean solution from the flow cell and fluidics lines:

• Before running setup or samples, run Fluidics Startup.

• To shut down without running more samples, run Fluidics Shutdown.

BD FACSDiva softwareBD FACSCanto clinical software
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Purging the Bubble Filter

1 Choose Cytometer > Cleaning Modes > Bubble Filter Purge (Bubble Filter 
Purge and Degas Flow Cell).

2 Wait while the purge finishes.

3 Click OK when the completion message displays.

4 Repeat steps 1 through 3 until bubble-free liquid enters the flow cell from 
the bubble filter.

5 If you are using BD FACSCanto clinical software, choose Cytometer > 
Cleaning Modes > De-gas Flow Cell. 

BD FACSDiva softwareBD FACSCanto clinical software

BD FACSCanto clinical software BD FACSDiva software
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Decontaminating the Fluidics System for Storage

1 Perform steps 1 through 4 in Decontaminating the Fluidics System (Long 
Clean) on page 160.

2 Shut down the software and turn off the power to the cytometer.

3 Wipe down the SIT and the aspirator arm with DI water. See Shutting 
Down on page 147 for more information.

Replacing the Bal Seal

Over time, saline deposits may develop on the interior surface of the SIT Bal seal 
retainer, causing an incomplete SIT flush between samples. Therefore, you should 
always rinse the retainer in DI water when you replace a Bal seal.

Figure 10-6  Bal seal and retainer

retainer

SIT

Bal seal
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1 Turn off the cytometer.

2 If you have a Loader installed: 

• Open the Loader doors.

• Pull out the drawer.

• If needed, remove the carousel.

• Move the tube guide to manual position. See step 2 on page 51.

3 Unscrew the retainer by turning it in the direction shown.
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4 Lower the retainer down the SIT and let it rest on the aspirator arm.

5 Access the Bal seal at the notch on the right side of the SIT assembly. 
Unseat the Bal seal by using the Bal seal removal tool (Figure 10-7 on 
page 178) to gently pull it downward.
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Figure 10-7  Bal seal removal tool

6 Allow the Bal seal to slide down the SIT and rest on top of the retainer.

7 Center the Bal seal on the retainer. With one hand, support the retainer and 
Bal seal and with the other hand, move the aspirator arm to the left. Lower 
the retainer and Bal seal from the SIT.

See Figure 10-8 on page 179.

use this end to remove Bal seal 

Bal seal
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Figure 10-8  Removing the Bal seal and retainer from the SIT

8 Hold the new Bal seal spring-side up (see figure), and slide it up the SIT. 
Use both hands to gently push it into its seated position. 

! Tip     If the Bal seal is not quite in its seated position, replacing the retainer 
will seat it correctly.

Bal seal, 
spring side up
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9 Rinse the retainer in DI water before replacing it on the SIT.

10 Reinstall the retainer over the SIT and tighten in the direction shown.

11 Test the installation by manually loading a tube onto the SIT and running 
fluid.

12 If you are using a Loader, ensure that the system is ready for automatic 
loading. See Figure 8-3 on page 136.
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Reconnecting the Fluidics Cart Tubing

! Tip     The ports and connectors are color coded.

Figure 10-9  Cytometer and fluidics cart ports

Cytometer ports and their corresponding fluidics cart ports are listed in 
Table 10-1 on page 182. See Table 10-2 for port functions.

f

g

d

c

b

a

e

i

mj

k o

n

h l

cytometer ports fluidics cart ports
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Table 10-1  Correspondence of cytometer ports to fluidics cart ports

Port or Button on Cytometer Port on Fluidics Cart

a. System Power —

b. Power Out k. Power In

c. Air In m. Air Out

d. Waste (A) o. Waste

e. Communications j. Communication

f. Sheath (B) i. Fluid Out

g. Waste (A) n. Waste

— h. On/Off

— l. Air In

Do not plug the fluidics cart power cord into a wall outlet. Plug the cord 
into the cytometer only. This ensures proper electrical grounding and 
protects against electrical shock or damage to the cytometer.

Table 10-2  Function of ports, buttons, and switches

Port or Switch Additional Information

a. System Power Powers both cytometer and fluidics cart

b. Power Out Connects to fluidics cart

c. Air In 70±5 psi

d. Waste (A) Waste out (aspirated)

e. Communications Data port

f. Sheath (B) BD FACSFlow solution port

g. Waste (A) Waste out (non-aspirated)

h. On/Off Auxiliary air supply switch. Keep in off 
position unless connected to house air.
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Replacing the Fluidics Level Sensors

Before you replace a suspected faulty sensor, try rinsing it with DI water to 
restore operation.

i. Fluid Out BD FACSFlow solution port

j. Communication Data port

k. Power In Connects to cytometer. Do not connect to 
wall outlet

l. Auxiliary Air In There will be no tubing on this port unless 
connected to house air.

m. Air Out Sends compressed air to cytometer

n. Waste Waste in (non-aspirated)

o. Waste Waste in (aspirated)

If you are changing the sensor on the waste container, use proper 
precaution and wear suitable protective clothing, eyewear, and gloves. All 
biological specimens, and materials coming into contact with them, can 
transmit potentially fatal disease.

The waste container can become pressurized when the cytometer is 
running. Always disconnect the waste container from the fluidics cart and 
wait at least 30 seconds for pressure to dissipate before you remove the 
level sensor cap.

Table 10-2  Function of ports, buttons, and switches (continued)

Port or Switch Additional Information
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1 Ensure that the cytometer is not acquiring events.

2 Detach the sensor and fluid line from the cart.

3 Unscrew the cap on the cubitainer.

4 Remove the level sensor assembly and discard into a suitable receptacle.
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5 Put a new level sensor assembly on the cubitainer or waste container. 
Hand-tighten the cap until it is fully closed.

Figure 10-10  Level sensor assemblies

6 Reattach the sensor line and fluidics lines.

7 If you replaced any level sensors (other than the waste sensor), prime the 
affected fluidics lines.

Important: Continue with the procedure in Priming Fluidics Lines on 
page 169.

To ensure that the appropriate solutions are dispensed, make sure the label 
on the container matches the labeled port on the fluidics cart.

waste level sensor 
(red connector)

BD FACSFlow level sensor 
(blue connector)

BD FACSClean solution and 
BD FACS shutdown solution 
level sensor (yellow connector)
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Replacing the Fluidics Cart Fuses

1 Shut down the cytometer and turn off the cytometer power.

2 Unplug the power cord from the wall outlet and the fluidics cart.

Removing the plug allows easier access to the fuse door.

3 Insert a small screwdriver into the slot and gently pry the fuse door open.

To protect against shock, always turn off the cytometer and unplug the 
power cord before performing this procedure.

slot for screwdriver

empty socket,
plug removed

fuse door

circuit breaker
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4 Gently pry out the fuse drawer until you can grip it.

5 Remove the fuse drawer, and remove and dispose of the old fuses.

! Tip     Note the positions of the old fuses before you remove them. Duplicate 
these positions with the new fuses.

fuse drawer

fuse door
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6 Replace both fuses.

Ensure that the fuses are positioned as shown.

7 Make sure the text for your country’s voltage is right-side up.

8 Slide the drawer back into the cytometer until it snaps into place.

9 Close the fuse access door.

10 Reconnect the power cord to the fluidics cart.

11 Plug the cytometer power cord into the wall outlet and switch on the power.

For protection against risk of fire, replace fuses only with those provided by 
BD Biosciences.

right wrong



189

11

Troubleshooting

The tips in this section can help you troubleshoot issues that might arise when 
using this cytometer. If you need additional assistance, contact BD Biosciences. 
Have the following information available: product name, catalog number, and 
serial number; any error messages; and details of recent system performance.

For cytometer support from within the US, call (877) 232-8995. For support 
from within Canada, call (888) 259-0187. Customers outside the US and 
Canada, contact your local BD representative or distributor. Refer to our website, 
bdbiosciences.com, for up-to-date contact information.
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Cytometer Troubleshooting

Observation Possible Causes Recommended Solutions

Flow cell will not fill Air in bubble filter For BD FACSCanto clinical 
software, run the Bubble Filter 
Purge command at least once (you 
might need to run it several times). 
When finished, run De-gas Flow 
Cell.

For BD FACSDiva software, run 
the Bubble Filter Purge and De-gas 
Flow Cell command at least once 
(you might need to run it several 
times).

Fluidics cart power off Turn on the power to the fluidics 
cart by resetting the fluidics cart 
circuit breaker switch (Figure 1-7 
on page 24). Always use the 
cytometer power button, located 
on the left side of the cytometer, to 
turn the system off and on.

No pressure in plenum Check air supply components (see 
Figure 10-9 on page 181). 

• Check air supply connections.

• Check air supply tubing for 
kinks.

Sheath line disconnected 1 Check cubitainer-to-fluidics 
cart, and fluidics cart–to-
cytometer connections. See 
Reconnecting the Fluidics Cart 
Tubing on page 181.

2 Check tubing for kinks.

BD FACSFlow cubitainer 
empty

Replace the BD FACSFlow 
cubitainer. See Changing a 
Cubitainer on page 166.
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Flow cell will not fill
(continued)

Air in BD FACSFlow filter 
(fluidics cart)

Purge air from the filter. See 
Priming Fluidics Lines on 
page 169.

Air lock in BD FACSFlow 
filter (on fluidics cart)

See Removing an Air Lock on 
page 169.

No air pressure in cart • If the cart is attached to an 
auxiliary air supply, switch on 
auxiliary air.

• If the cart is not attached to an 
auxiliary air supply, switch off 
auxiliary air.

Fluid backfill into 
sample tube

Cracked tube • Transfer sample to new tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 28.

Bal seal improperly installed 
or worn

Reinstall or replace the Bal seal. 
See Replacing the Bal Seal on 
page 175.

Air lock in BD FACSFlow 
filter

See Removing an Air Lock on 
page 169.

Tube partially removed from 
SIT after acquisition

Once you start to remove a tube 
from the SIT, complete the action.

Low laser power 
indication

Flow cell access door open Close the door completely.

Laser power output is below 
requirement

Call BD Biosciences.

Backflushing of sheath 
fluid into sample tube

Aspirator arm bumped or 
moved to side, but tube was 
not removed

1 Repeat tube removal sequence.

2 Perform a manual SIT flush.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Fluidics pressure errors Air lock in filter Check the filter in the fluidics cart. 
Verify the bottom bleeder valve on 
the filter is fully tightened. Open 
the top bleeder valve. If no fluid 
leaks out, remove the air lock as 
described in Removing an Air 
Lock on page 169.

Cytometer on, no 
response to software 
commands

Bad keyboard or mouse 
connection

Check keyboard or mouse 
connections to computer. Refer to 
the documentation that came with 
your workstation.

Communication failure 
between computer and 
cytometer

1 Turn off the computer and the 
cytometer.

2 Reseat the Ethernet cable, 
located next to the power cord 
on the right side of the flow 
cytometer.

3 Turn on the cytometer, then the 
computer.

User-installed firewall • Contact your system 
administrator to open a port in 
the firewall for cytometer.

• Call BD Biosciences.

QC fails after Long 
Clean

Residual BD FACSClean 
solution in lines

Run Fluidics Startup to flush the 
system with sheath fluid. Repeat 
until QC passes.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions

RS-232 cable

Ethernet cable
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Tube does not load, or
sample tube does not fit 
snugly on SIT

Improper tubes used Use only uncapped 12 x 75-mm 
BD Falcon polystyrene test tubes, 
BD Trucount tubes, and BD FACS 
7-color setup beads tubes. See 
System Requirements on page 28.

Defective or cracked tube • Transfer sample to new tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 28.

Bal seal improperly installed 
or worn

Reinstall or replace the Bal seal. 
See Replacing the Bal Seal on 
page 175.

Cytometer and fluidics 
cart will not turn on

Power cord disconnected 
from wall socket or cytometer

Reconnect the power cord to the 
wall socket or the cytometer.

Cytometer circuit breaker 
tripped

Switch on the cytometer circuit 
breaker, followed by the 
cytometer power (if off).

Blown fuse in cytometer 
controller

Turn off the cytometer main 
power and call BD Biosciences.

Fluid leaking from SIT or 
aspirator arm

Interior valve failure or leak 1 Turn off the cytometer power.

2 Clean up the liquid, using 
proper precautions.

3 Call BD Biosciences.

Waste line to fluidics cart 
disconnected

1 Turn off the cytometer power.

2 Clean up the liquid, using 
proper precautions.

3 Check that waste lines are 
securely plugged in.

4 Turn on the cytometer power.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Liquid leakage around 
cytometer base

Interior valve failure 1 Turn off the cytometer power.

2 Clean up the liquid, using 
proper precautions.

3 Call BD Biosciences.

Aspirator arm locked, 
cannot unload tube

Software not responding Do not use force to remove 
tube from SIT.

1 Press Ctrl-Alt-Delete to open 
Task Manager.

2 Choose End Task to close 
BD FACSCanto clinical 
software or BD FACSDiva 
software application.

3 Restart software and unload 
tube.

Pressure loss Verify fluidics cart is powered on 
and that air pressure hoses are 
properly connected.

Fluidics error after 
replacing sheath fluid or 
emptying waste

Status change not yet detected 
by software

After replacing or emptying fluids, 
wait until software detects status 
change before restarting 
acquisition.

It can take up to 30 seconds for 
the software to detect a fluid level 
change.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Loader Troubleshooting

Observation Possible Causes Recommended Solutions

Tube does not load Tube not completely raised Ensure the Loader drawer is 
completely shut. 

Ensure the tube is free of bulky 
labels or tape.

Tube lifter hitting carousel 
during ascent

Ensure the carousel is properly 
engaged with the alignment guide 
pin. If the problem persists, 
contact BD Biosciences for 
assistance.

Tube lifter failure Contact BD Biosciences.

Tube does not unload Tube lifter failure 1 If the tube lifter is in the up 
position, turn off the cytometer 
or Loader power for 
approximately 5 minutes. 

The air in the tube lifter will 
decompress, lowering the tube 
lifter.

2 Remove the tube.

If the problem persists, contact 
BD Biosciences.

Status change not yet detected 
by software

After replacing or emptying fluids, 
wait until software detects a status 
change before restarting 
acquisition.

It can take up to 30 seconds for 
the software to detect a fluid level 
change.
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Tube missed, or missing 
tube messages in 
software

Salt crystal buildup on optical 
sensors

Clean the tube optical sensor 
(outer sensor), as described in 
Cleaning External Surfaces on 
page 171.

Condensation on tube Wipe tube.

Tube label reflection Turn tube.

Tube not detected Optical sensor is wet or dirty • Clean sensor

• Allow time for sensor to dry

Loader stalls or emits a 
grinding noise

Door opened during Loader 
initialization

When the Loader stops moving, 
open and close the Loader doors.

Do not open the Loader doors 
while the Loader is in motion.

Tube runs dry, Loader 
not advancing to next 
sample

Dilute sample or rare events Set a stopping time in 
BD FACSDiva software. 
See step 2 on page 139.

Bubble in flow cell diverts 
stream

Degas flow cell. See Removing 
Bubbles from the Flow Cell on 
page 172.

Communication error 1 Restart the system.

2 Perform fluidics startup.

See step 5 on page 47.

Loader Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Disabling the Loader in BD FACSCanto Clinical Software

If a problem occurs that requires you to temporarily disable the Loader and run 
tubes manually, you can make the software behave as though a Loader is not part 
of your system. Dialogs reminding you to insert the Loader and other software 
notifications no longer appear.

1 In BD FACSCanto clinical software, choose Tools > Options.

2 Click .

3 Select the checkbox in the Run Options dialog:

Test tube stuck on SIT, 
software not responding

• Cytometer not set up for 
automatic loading

• Software problem

Remove the tube from the SIT 
manually.

1 Hold the tube and move the 
aspirator arm aside.

2 Gently pull the tube off the SIT.

3 Release the aspirator arm.

4 Restart the software.

5 If needed, modify the cytometer 
for automatic loading.

Carousel not rotating 
correctly

Carousel not engaged with 
alignment pin on drawer

Rotate the carousel on the spindle 
until the alignment guide pin 
engages with the alignment hole, 
and press down. See step 4 on 
page 137. If the problem persists, 
contact BD Biosciences for 
assistance.

Aspirator arm bar vertical Rotate the bar to the forward 
horizontal position. 

Loader Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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4 Click .

Fluidics Cart Troubleshooting

Observation Possible Causes Recommended Solutions

Water leakage around 
fluidics cart base

• Normal condensation 
overflow from pressure 
relief valve

• Extremely humid climate

1 Turn off the cytometer power.

2 Clean up the water.

3 Empty the condensation trap in 
the fluidics cart daily. See 
Figure 1-6 on page 22.

Bleeder valve on fluidics cart 
filter open

1 Turn off the cytometer power.

2 Clean up the liquid.

3 Check and close all bleeder 
valves. See Purging the Fluidics 
Filters on page 158.

Broken fluid line Contact BD Biosciences.

Fluidics cart will not 
power on, cytometer on

Cart circuit breaker off Switch on the cart circuit breaker.

Auxiliary air supply switch is 
on, cart not normally 
connected to auxiliary air

Toggle the auxiliary air supply off. 
When auxiliary air is on, the cart’s 
own air pumps turn off.

Power cord from fluidics cart 
to cytometer disconnected

Connect both ends of the cord.

Fuse blown Replace the fluidics cart fuses. See 
Replacing the Fluidics Cart Fuses 
on page 186.
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BD FACSCanto Clinical Software Troubleshooting

Acquisition Indicator Lights

The acquisition indicator lights may provide important information when 
troubleshooting software related issues. Ensure that these lights are on (see 
Electronics Components on page 20). 

BD FACSCanto Software General Issues

Observation or Error 
Message Possible Causes Recommended Solutions

Software not responding Software frozen 1 Press Ctrl-Shift-Esc. Locate 
BD FACSCanto clinical 
software in the Windows 
Task Manager; click End 
Task.

If acquisition is in 
progress, data will be lost.

2 Restart software. To prevent 
carryover, perform fluidics 
startup before acquiring data 
by choosing Cytometer > 
Fluidics Startup.

Software does not 
connect to cytometer

BD FACSDiva software 
running

• Quit BD FACSDiva software.

OR

• In BD FACSDiva software, 
put the cytometer in standby: 
choose Cytometer > Standby.

Cytometer power is off Turn power on.

Internal firmware error Cycle power on cytometer.

Ethernet disconnected See page 192.
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Connection error 
messages

Various • Follow any message 
directions.

• Ensure the cytometer power 
is on.

• Check the Ethernet cable 
connection to the cytometer 
and computer.

• Verify the fluidics cart is 
plugged in and the power on.

• Shut down the software, 
computer, and cytometer, and 
then restart them.

Barcode reader error Dirty barcode reader 
window

Clean barcode reader window 
with isopropyl or ethyl alcohol 
and try again.

Blurred or damaged 
barcode label

Try scanning with a duplicate 
label (if available), or enter data 
manually.

BD FACSCanto Software General Issues (continued)

Observation or Error 
Message Possible Causes Recommended Solutions
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Tube not present error Tube not seated on SIT Push tube all the way up onto 
the SIT.

Cracked tube • Transfer sample to new tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 28.

Fluid at top of tube 
prevents detection

Wipe inside top of tube with 
clean cotton swab. Dispose of 
swab with biohazardous 
materials.

Tube sensor wet or 
damaged

• Allow time for sensor to dry.

• Reduce solution volumes to 
$3 mL.

• Call BD Biosciences.

BD FACSCanto Software General Issues (continued)

Observation or Error 
Message Possible Causes Recommended Solutions
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Tube pressurization 
errors

Cracked tube • Transfer sample to new tube.

• Make sure you are using 
appropriate tubes. 

Drop at top of tube Dry the inside of the tube with a 
cotton swab and re-run.

Bal seal improperly 
installed or worn

Reinstall or replace the Bal seal. 
See page 175 for instructions.

Loader misaligned 1 Try running in manual mode 
instead of automatic. See 
step 2 on page 51 for 
converting to manual mode.

2 If unsuccessful, call 
BD Biosciences.

Wrong tubes used Make sure you are using 
recommended tubes. See System 
Requirements on page 28.

Tubing to fluidics cart 
kinked or disconnected

Reconnect or straighten the 
tubing. See page 181.

Tube not detected Tube not seated on Bal 
seal properly

• Ensure that the tube is all the 
way up onto the Bal seal.

• Ensure you are using 
appropriate tubes. See System 
Requirements on page 28.

• Replace or reinstall Bal seal.

Vacuum error Tubing to fluidics cart 
kinked or disconnected

Reconnect or straighten the 
tubing. See page 181.

BD FACSCanto Software General Issues (continued)

Observation or Error 
Message Possible Causes Recommended Solutions
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BD FACSCanto Software Setup Wizard Messages

Messages Possible Causes Recommended Solutions

No acquisition events 
were received from 
cytometer

Communication problem 
between hardware and 
software

1 Turn on the power.

2 Connect the Ethernet cable to 
the cytometer and computer.

3 Shut down the software, 
computer, and cytometer, and 
restart them.

4 To prevent carryover, perform 
a fluidics startup before 
acquiring data. Choose 
Cytometer > Fluidics Startup.

Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Laser failure Check the laser power in the 
Status window. If outside the 
acceptable range, call 
BD Biosciences.

Clogged SIT Clean the flow cell.

Failed to place [name of 
beads] on scale.

or

Failed to find [name of 
beads]

Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Software using saved 
settings from a failed 
setup

Delete the SetupResults.dat file 
from C:\Program Files\ 
Common Files\BD\Setup 
Results, and run setup again.

No valid data points Internal setup error Delete the SetupResults.dat file 
from C:\Program Files\ 
Common Files\BD\Setup 
Results, and run setup again.
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A communication error 
was encountered

Communication problem 
between hardware and 
software

1 Turn on the power.

2 Connect the Ethernet cable to 
the cytometer and computer.

3 Shut down the software, 
computer, and cytometer, and 
restart them.

Fluidics cart off or 
disconnected

Switch on the fluidics cart circuit 
breaker; make sure the power 
cable is connected at both ends.

Cytometer setup was 
aborted by user

Setup aborted Perform setup again.

Cytometer setup was 
aborted because the 
loader doors were 
opened

Loader doors opened Perform setup again, keeping 
loader doors closed.

There is a vacuum error Vacuum tubing to waste 
cart disconnected

Reconnect waste tank or tubing, 
and remove kinks.

Waste tank disconnected, 
waste tubing 
disconnected or pinched

Clogged aspirator arm Call BD Biosciences.

BD FACSCanto Software Setup Wizard Messages 

Messages Possible Causes Recommended Solutions
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There is a float switch 
error

Sheath tank not attached 
to fluidics cart

Reconnect sheath cubitainer or 
tubing, and remove kinks. 

Sheath tubing from 
fluidics cart to cytometer 
not attached or pinched

Sheath filter not primed Always prime after changing a 
cubitainer.

Fluidics airlock See Removing an Air Lock on 
page 169. 

Fluidics cart off or 
disconnected

Switch on the fluidics cart circuit 
breaker; make sure the power 
cable is connected at both ends.

Low or no pressure • Check air supply connections.

• Check air pressure gauge.

BD FACSCanto Software Setup Report Failure 
Messages

Failed Possible Causes Recommended Solutions

Detector voltage Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Wrong target value used Match the target values in the 
software to those printed on the 
BD FACS 7-color setup beads label. 
Re-enter them, if needed.

Setup.dat file deleted Accept the failed setup, and then re-
run Setup.

BD FACSCanto Software Setup Wizard Messages 

Messages Possible Causes Recommended Solutions
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Sensitivity Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Dirty flow cell Clean the flow cell.

Spectral overlap Expired bead lot Run setup again with fresh tube of 
setup beads.

Software using saved 
setting from a failed 
setup

Delete the SetupResults.dat file from 
C:\Program Files\Common 
Files\BD\Setup Results, and run 
setup again.

Incorrect spectral 
overlap factors used

Match the spectral overlap factors 
in the software to those printed on 
the BD FACS 7-color setup beads 
label.

Laser power Laser failure Check the laser power in the Status 
window. If outside the acceptable 
range, call BD Biosciences.

Sheath pressure Kinked or clogged sheath 
line

Remove any kinks in tubing to the 
fluidics cart.

Clogged or airlocked 
sheath filter

Check the sheath filter. Open the 
bleeder valves. If no fluid leaks out, 
remove the air lock.

BD FACSCanto Software Setup Report Failure 
Messages (continued)

Failed Possible Causes Recommended Solutions
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BD FACSCanto Software Levey-Jennings Errors and 
Messages

Observation Possible Causes Recommended Solutions

LJ plots empty, no data, 
no error message appears

BD FACS Setup Beads-7 
colors LJ.csv file missing

• If the file was renamed, 
rename it with its original 
name, and click Refresh.

• If the file was moved from the 
default directory, move it 
back, and then click Refresh.

LJ plots empty, no data, 
error message appears

BD FACS Setup Beads-7 
colors LJ.csv file 
corrupted or contains 
invalid data

Delete the BD FACS Setup 
Beads-7 colors LJ.csv file, and 
run setup again. The software 
will create a new set of plots.

BD FACS Setup Beads-7 
colors LJ.csv file open or 
in use by another 
application

1 Close the file or application.

2 Click Refresh.

BD FACSCanto Software Acquisition

Observation Possible Causes Recommended Solutions

No events in plots after 
clicking Run,
acquisition indicator 
lights are blinking as 
expected

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 

Detector voltage too low Increase the voltage. 

No events in plots after 
clicking Run;
acquisition indicator 
lights, except for those 
corresponding to 
threshold parameters, 
are blinking as expected

Threshold too low or too 
high

Adjust the threshold.

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 
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No events in plots after 
clicking Run,
NO acquisition indicator 
lights are blinking
(no fluorescent signal)

Cracked tube • Transfer sample to new tube.

• Make sure you are using 
appropriate tubes. 

SIT clogged Clean the flow cell.

Current cytometer 
configuration different 
from optical setup

Verify the cytometer 
configuration corresponds to the 
cytometer’s optical setup.

Laser delay set 
incorrectly

Contact BD Service.

Unexpectedly high event 
rate

Threshold too low Increase the threshold. 

Sample too concentrated Dilute the sample. 

Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Unexpectedly low event 
rate

Threshold too high Decrease the threshold.

SIT clogged Clean the flow cell.

Excessive amount of 
debris in plots

Threshold too low Increase the threshold. 

Dead cells or debris in 
sample

Examine the sample under a 
microscope.

Stained sample too old Check the reagent package 
insert.

FCS file not created PC hard disk full 1 Delete unnecessary files.

2 Run disk utilities regularly.

BD FACSCanto Software Acquisition (continued)

Observation Possible Causes Recommended Solutions
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Acquisition stops High event rate (>10,000 
events/sec) with more 
than 8 compensated 
parameters

• Increase threshold.

• Decrease threshold channel 
gain.

• Dilute sample.

• Define only channels of 
interest in parameter list.

Distorted populations or 
unexpected pattern in 
plot

Cytometer settings 
adjusted incorrectly

Optimize the scatter parameters.

Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Flow cell dirty Clean the flow cell.

SIT not cleaned between 
tubes

• Choose Cytometer > 
Cleaning Modes > SIT Flush.

Incorrect gating Verify the gating.

BD FACSCanto Software Acquisition (continued)

Observation Possible Causes Recommended Solutions
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BD FACSCanto Software TBNK Analysis 
QC Messages

Message Possible Causes Recommended Solutions

Sample quality 
questionable

Donor-specific anomaly Adjust gates manually to include 
required subsets. 

Insufficient mixing 
during sample 
preparation: cell 
populations elongated in 
CD3 vs SSC and FITC vs 
PE plots

Re-stain the sample. Vortex after 
blood and reagent are added to 
tube. Make sure no blood 
remains on the side of the tube.

Sample not lysed 
adequately: cell 
populations in CD45 vs 
SSC extend upward

Prepare sample again, ensuring 
complete lysis.

Aged blood and/or 
stained sample: 
granulocytes have low 
side scatter in CD45 vs 
SSC plot; no distinct 
monocyte population

Refer to the information 
supplied with the reagent for 
stability limitations.

Excessive mixing: debris 
encroaching on 
populations in CD45 vs 
SSC plot

Re-stain the sample and run it 
again.

Low voltage for SSC 
detector 

Increase the SSC voltage and run 
the sample(s) again.

Various Look at the dot plots in 
BD FACSCanto Software Four- 
and Six-Color TBNK on 
page 212. Re-run the sample.

Sample not mixed 
properly

Vortex prior to loading the 
sample onto the SIT.
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Insufficient beads 
acquired (<500) 

Cell concentration too 
high

Dilute the sample, re-stain, and 
run it again.

% T-sum failure Large number of double-
positive or double-
negative T cells

Inspect the gates and include all 
required events. Adjust gates 
manually, if needed.

Lymphosum failure Events incorrectly 
classified as T, B, or NK

Inspect the gates and make sure 
required events are included. 
Adjust gates manually, if needed.

Laser power low during 
recording: Visually 
inspect.

Data collected with low 
laser power

Inspect the data. 

If the power is outside the 
acceptable range, call 
BD Biosciences.

Lymph gate failure: Gate 
manually.

No usable lymph gate • Adjust the lymph gate 
manually.

• If necessary, run the sample 
again.

BD FACSCanto Software TBNK Analysis 
QC Messages (continued)

Message Possible Causes Recommended Solutions
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BD FACSCanto Software Four- and Six-Color TBNK

The following examples provide some assistance in troubleshooting BD Multitest 
reagent plots.

Observation Possible Causes Recommended Solutions

Cell populations in 
CD45 vs SSC extend 
upward

Inadequate lysing of 
sample

Prepare sample again, and 
ensure complete lysis.

Granulocytes with low 
side scatter in CD45 vs 
SSC plot, no distinct 
monocyte population

Aged blood or stained 
cells

Refer to the reagent package 
insert for stability limitations.
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BD FACSCanto Software Four- and Six-Color TBNK 
(continued)

Observation Possible Causes Recommended Solutions

Debris encroaching on 
populations in CD45 vs 
SSC plot

• Excessive mixing

• Aged blood or stained 
cells

Prepare sample again.

Vertically compressed 
populations

Side scatter too low Reacquire sample. Set SSC so 
granulocytes reach to top of 
CD45 vs SSC plot.

Lipemic sample Check reagent package insert for 
instructions.



214 BD FACSCanto II Instructions for Use

Indistinct populations; 
events sparse or missing 
from one population; 
lack of separation 
between CD3– and 
CD3+ cluster

Incorrect spectral overlap Re-run setup, optimizing for 
application. Re-run sample.

Granulocytes cut off at 
top of plot; stretched 
monocyte population

High SSC Re-run setup, optimizing for 
application. Re-run sample, 
lowering the SSC.

BD FACSCanto Software Four- and Six-Color TBNK 
(continued)

Observation Possible Causes Recommended Solutions
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BD FACSDiva Software Troubleshooting

Acquisition Indicator Lights

The acquisition indicator lights may provide important information when trou-
bleshooting software related issues. Ensure that these lights are on (see Electron-
ics Components on page 20). 

BD FACSDiva Software General Issues

Observation Possible Causes Recommended Solutions

Cytometer 
Disconnected in 
Cytometer window

(software does not 
connect to cytometer)

BD FACSCanto clinical 
software running

• Quit BD FACSCanto clinical 
software.

• In BD FACSCanto clinical 
software, put the cytometer in 
standby: choose Cytometer > 
Standby.

Cytometer power is off Turn power on.

Internal firmware error Cycle power on cytometer.

Communication failure 
between software and 
cytometer

• Quit the software and restart it. 

• If unsuccessful, cycle the 
cytometer power. Restart the 
computer.

Ethernet cable 
disconnected 

Unplug and then plug in the cable 
connectors. 

Cytometer not 
responding
status message

Various Switch the cytometer power off, 
and then on. Restart the computer. 
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Unable to access 
database

Adaptive Server 
Anywhere™ not 
running

Verify that the database server has 
been started.

1 Choose Start > Settings > 
Control Panel and double-click 
the Administrative Tools icon.

2 Double-click the Services icon. 

3 Select Adaptive Server 
Anywhere. If the Start button is 
enabled, click the button to start 
up the database server. If the 
buttons are greyed out, the 
database could be loading. 

Software not 
responding

Saving or loading large 
data file

Look for screen activity. If there is 
no activity, wait 1–2 minutes, and 
then restart the software.

Calculating large 
number of statistics

Calculating statistics is memory-
intensive. When calculating many 
statistics on a large number of 
displayed events, wait 1–2 minutes 
before using the software. 

Waiting for response 
from cytometer

Wait until cytometer action is 
complete. If after 2 minutes no 
timeout is received, restart 
cytometer and software.

After restarting software, to 
prevent carryover, perform a 
fluidics startup before acquiring 
data:

Choose Cytometer > Fluidics 
Startup.

BD FACSDiva Software General Issues (continued)

Observation Possible Causes Recommended Solutions
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Software not 
responding (continued)

1 Press Ctrl-Shift-Esc. Locate 
BD FACSCanto clinical 
software in the Windows Task 
Manager; click End Task.

If acquisition is in progress, 
data will be lost.

2 Restart software. To prevent 
carryover, perform fluidics 
startup before acquiring data by 
choosing Cytometer > Fluidics 
Startup.

Software message 
“Hardware key not 
accessible...”

Security module 
disconnected

Reconnect the security module to 
the USB port, and restart the 
software.

Error message in 
Status tab

(Refer to text in error 
message)

Follow instructions in error 
message.

Communication or 
fluidics error

Shut down the computer and 
cytometer, and restart them. If the 
message reappears, contact 
technical support. Provide exact 
wording of the status message.

BD FACSDiva Software General Issues (continued)

Observation Possible Causes Recommended Solutions
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Faulty screen display, 
display objects 
distorted or unreadable

Pointer shadow 
enabled

Disable the pointer shadow:

Select Start > Settings > Control 
Panel. Double-click the Mouse icon 
and select the Pointers tab. 
Deselect the Enable pointer 
shadow checkbox. Click OK.

Graphics hardware 
acceleration set too 
high

Decrease the acceleration:

Right-click on the desktop and 
select Properties. Click the Settings 
tab. Click the Advanced button. 
Click the Troubleshooting tab and 
drag the hardware acceleration 
pointer to the left.

Non-standard DPI 
setting

Revert to the default DPI:

Right-click on the desktop and 
select Properties. Click the Settings 
tab. Click the Advanced button. 
With the General tab selected, use 
the drop-down menu to set DPI to 
96 (normal size).

BD FACSDiva Software General Issues (continued)

Observation Possible Causes Recommended Solutions
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BD FACSDiva Software Cytometer Setup

Observation Possible Causes Recommended Solutions

Error creating 
compensation tubes

Naming conflict with 
existing tube or 
worksheet

1 Locate the tube or worksheet 
named (ParameterName) 
Stained Control, and change 
the name. 

2 Create the compensation 
tubes again.

Error calculating 
compensation

PMT voltages 
inconsistent between 
compensation tubes

Re-record all compensation 
tubes with the same PMT 
settings.

Wrong tube run for 
stained control tube

Re-record all compensation 
tubes and recalculate. 

Insufficient separation 
between positive and 
negative populations

Adjust compensation to see if it 
improves. If it does not, re-
record the compensation tubes, 
draw new gates, and calculate 
compensation again.

If automatic compensation fails, 
perform manually. 
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BD FACSDiva Software Acquisition 

Observation Possible Causes Recommended Solutions

No events in plots after 
clicking Acquire, 
acquisition indicator 
lights are blinking as 
expected (viewing 
normal worksheet)

(viewing normal or 
global worksheet)

Current tube pointer not 
on current tube

Move the current tube pointer in 
front of the appropriate tube.

Viewing plots for a 
different tube

Double-click the current tube in 
the Browser to display the plots 
for that tube.

Incorrect population(s) 
in plot

Right-click the plot and choose 
Show Populations; inspect the 
populations.

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 

Detector voltage too low Increase the voltage. 

No events in plots after 
clicking Acquire;
acquisition indicator 
lights, except for those 
corresponding to 
threshold parameters, 
are blinking as expected

Threshold too low or too 
high

Adjust the threshold.

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 
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No events in plots after 
clicking Acquire, 
NO acquisition indicator 
lights are blinking

Cracked tube • Transfer sample to new tube.

• Make sure you are using 
appropriate tubes. 

SIT clogged Clean the flow cell.

Current cytometer 
configuration different 
from optical setup

Verify the cytometer 
configuration corresponds to the 
cytometer’s optical setup. If it 
does not, contact your System 
Administrator.

Incorrect sample 
preparation

Re-stain and re-run samples.

Indicator light switch off Turn indicator light switch on.

Laser delay set 
incorrectly

Contact your lab manager to 
correct the laser delay settings.

Area scaling factor set 
incorrectly

Contact your lab manager to 
correct area scaling factor 
settings.

Fluorescent signal 
missing

Current cytometer 
configuration different 
from optical setup

Verify the cytometer 
configuration corresponds to the 
cytometer’s optical setup, and 
parameter list includes 
appropriate parameters.

Laser delay set 
incorrectly

Contact your lab manager to 
correct the laser delay settings. 

Area scaling set 
incorrectly

Contact your lab manager to 
correct the laser delay settings. 

Fluorescence threshold 
set too high

Adjust threshold.

Incorrect sample 
preparation

Re-stain and re-run samples.

BD FACSDiva Software Acquisition  (continued)

Observation Possible Causes Recommended Solutions
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Unexpected results after 
clicking Next

Current tube pointer on 
wrong tube

Put the current tube pointer in 
front of the appropriate tube 
before clicking Next.

Unexpectedly high event 
rate

Threshold too low Increase the threshold. 

Sample flow rate too 
high

Decrease the flow rate.

Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Unexpectedly low event 
rate

Threshold too high Decrease the threshold. 

Erratic event rate Sample aggregates Filter the sample.

Distorted scatter 
parameters 

Cytometer settings 
adjusted incorrectly

Optimize the scatter parameters. 

Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Excessive amount of 
debris in plots

Threshold set too low Increase the threshold. 

Dirty sheath filter Replace sheath filter.

Dirty flow cell Clean flow cell. See page 173.

High CVs Sample flow rate too 
high

Decrease the flow rate.

Window extension set 
incorrectly

Contact lab manager to set the 
window extension to 7.0.

BD FACSDiva Software Acquisition  (continued)

Observation Possible Causes Recommended Solutions
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Acquisition stops High event rate (>10,000 
events/sec) with more 
than 8 compensated 
parameters

• Increase threshold.

• Decrease threshold channel 
gain.

• Dilute sample.

• Define only channels of 
interest in parameter list.

Fewer events than 
expected in gated 
population

Window extension set 
incorrectly

Contact lab manager to set the 
window extension to 7.0.

On-axis events left out of 
gate

Include events on the axis.

Gates improperly set Check gating strategy.

Dirty sheath filter Replace sheath filter.

Dirty flow cell Clean flow cell. See page 173.

High electronic abort 
rate (>10% of system 
event rate)

Event rate too high Decrease the flow rate.

Sample too concentrated Dilute the sample.

Threshold set too low Increase the threshold.

Window extension set 
incorrectly

Contact lab manager to set the 
window extension to 7.0.

Increasing threshold 
results in decreased area 
signal

Window extension set 
too low

Set the window extension to 7.0

Area measurement off-
scale while height 
measurement is on scale

Area scaling set too high Contact your lab manager to 
correct area scaling settings.

BD FACSDiva Software Acquisition  (continued)

Observation Possible Causes Recommended Solutions
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BD FACSDiva Software Analysis 

Observation Possible Causes Recommended Solutions

Fewer events than 
expected in gated 
population

Current tube pointer on 
wrong tube

Move the current tube pointer to 
the correct tube.

On-axis events left out of 
gate

Include events on the axis.

Gates improperly set Check gating strategy.

Missing analysis objects 
on worksheet 

Analysis objects 
obscured by other 
objects

Double-click the tube containing 
the analysis objects. Select the 
objects on the worksheet and 
move them.

Differing statistics 
between exported and 
imported file

Compensated data with 
negative values set to 
zero during FCS 2.0 
export

• Export the original data as 
FCS 3.0.

• Export FCS 2.0 data with 
compensation disabled.

• If statistical differences are 
significant, re-record the file.
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Display Troubleshooting

Observation Possible Causes Recommended Solutions

Software screen appears 
distorted (height is 
compressed; New Lot ID 
button is missing from 
Cytometer Setup 
Wizard)

• Display setting was 
changed from 96 dpi to 
120 dpi

1 Right-click the desktop and 
select Properties from the 
menu.

2 Click the Settings tab.

3 Click Advanced.

4 Click the General tab.

5 Select Normal Size (96 DPI) 
from the DPI Setting menu.

6 Click OK to restart the 
computer.
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Appendix A

Supplies and Replacement Parts

To order supplies and options, contact your local BD Biosciences representative.

For updated information and part numbers, refer to our website, 
bdbiosciences.com.

• Cytometer Supplies on page 228

• Consumables on page 230
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Cytometer Supplies

Installation Kit

The cytometer ships with an installation kit including the following items, many of 
which are used during installation. Use these part numbers to order replacements.

Item Part No.

Wet cart liquid filter assembly  33566307

1/4-in. elbow couplings 333072

6-ft cordset for US power (15A, 5–15P/320-C13) 337219

2.5-m cordset for Australian power (10A C13)  335696

2.5-m cordset for European power (10A C13) 335697 

2.5-m cordset for UK power (10A C13 R/A) 335698 

Filter bypass assembly 33576007

Bal seal for SIT 343509

Bal seal removal tool 331430

12 x 75-mm tubes 343675

10-L waste container 340261

Vented cap for waste container (pack of 12) 33885407

Waste cap baffle 33850507

Fluidics cart fuses: 2.5-A 250V Slo-blo Type T 343565

Loader front door assembly (Loader option only) 34401007

Loader side door assembly (Loader option only) 34349207

Preventive maintenance kit 64106807

Plastic O-ring pick tool 331430
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Other Replacement Parts

Barcode Reader Parts

Item Part No.

Sheath sensor probe (2-level) 338979

Waste sensor probe (2-level) 338978

Auxiliary sensor probe (1-level) 343835

Air filter (side door) 336303

Bal seal retainer 640116

Carousel kit, carousels 1–4 332727

Carousel kit, carousels 5–8 332728

Carousel kit, carousels 9–12 332729

Carousel kit, carousels 13–16 332730

Item Part No.

2D barcode reader 344025

Stand (bar code reader) 344026



230 BD FACSCanto II Instructions for Use

Consumables

Cytometer Setup

Reagents

Particle Supplier Catalog No.

BD FACS 7-color setup beads BD Biosciences
(877) 232-8995

335775

Reagent Supplier Catalog No.

BD FACSFlow sheath fluid BD Biosciences
(877) 232-8995

340398
(US and Latin America)

342003
(other countries)

BD FACSClean solution BD Biosciences 340345

BD FACS shutdown solution BD Biosciences 334224

Monoclonal antibodies BD Biosciences a

a. Refer to the BD Biosciences Immunocytometry Products Catalog or the BD Biosciences website 
(bdbiosciences.com).

BD FACS™ lysing solutionb

b. US Patent Nos. 4,654,312; 4,902,613; 5,098,849

BD Biosciences 349202



Appendix A: Supplies and Replacement Parts 231

Labware

Item Supplier Catalog No.

5-mL polystyrene test tubes, 
12 x 75-mm (BD Falcon tubes)

• uncapped, 125 per bag

• capped, 125 per bag

• capped, 25 per bag

• with cell-strainer cap, 
25 per bag

BD Biosciences
(877) 232-8995

• 352052 

• 352054

• 352058

• 352235
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Appendix B

Technical Specifications

• Cytometer Specifications on page 234

• Fluidics Cart Specifications on page 238

• BD FACS Loader Specifications on page 239

For barcode reader specifications, refer to the information supplied by the 
manufacturer.
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Cytometer Specifications

Dimensions Height: 64 cm (25.2 in.)

Width: 91 cm (35.7 in.)

Depth: 61 cm (24 in.)

Workspace dimensions Height (with flow cell access door open): 85 cm 
(33.5 in.)

Unit designed to fit lab bench 55.9 cm (22 in.) 
depth.

Operational clearances, cytometer Left side: 30 cm (11.8 in.) between unit and other 
objects or wall to permit proper air flow and access 
to the main power button and circuit breaker

Right side: 30 cm (11.8 in.) between unit and other 
objects or wall to permit proper air flow

Top: 22.5 cm (8.9 in.) between unit and other 
objects or wall to permit opening of flow cell access 
door

Weight $146 kg (320 lb)—cytometer only, excluding 
Loader and computer

Maximum 168 kg (370 lb)—including Loader

Power requirements 100/115/230 VAC (50–60 Hz)

Current: 

5A at 115 VAC 

2.5A at 230 VAC

Power consumption 500 W
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Environment

Performance

Optics

Laser Specifications

The following Class IIIb (3B) lasers are mounted on the BD FACSCanto II 
cytometer.

Storage temperature 5–40°C (41–104°F)

Operating temperature 16–31°C (59–86°F)

Operating relative humidity 20–80% (noncondensing)

Noise level $62 dBA

Facilities No special room requirements

Fluorescence threshold sensitivities FITC <100 MESF
PE <50 MESF

Forward and side scatter sensitivity Platelets can be resolved from noise

Forward scatter sensitivity 1 micron

Side scatter sensitivity 0.5 micron

 Manufacturer Model Wavelength 
(nm)

Power 
(mW)

Coherent Sapphire 488-20 488 20

JDS Uniphase 1144-P 633 17

Point Source
(optional)

iFLEX2000-P-1-405-0.65-30-
NP

405 30
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These lasers are contained within the cytometer, therefore the BD FACSCanto II 
flow cytometer is a Class I (1) laser product.

Excitation Optics

Emission Optics

Optical platform Fixed optical assembly

Beam geometry (all lasers) 9 µm x 65 µm elliptical beam

Collection lens Optical gel–coupled to flow cell

Numerical aperture (NA) = 1.2

Fluorescence detection 6 to 8 photomultiplier tube detectors:

Wavelength ranges detected from 488-nm laser:

• 750–810 nm (PE-Cy7)

• 670–735 nm (PerCP-Cy5.5)

• 610–637 nm (PE-Texas Red®, optional)

• 564–606 nm (PE)

• 515–545 nm (FITC)

Wavelength ranges detected from 633-nm laser:

• 750–810 nm (APC-Cy7)

• 701–723 nm (Alexa Fluor® 700, optional)

• 650–670 nm (APC)

Wavelength ranges detected from 405-nm laser:

• 502–535 nm (AmCyan)

• 425–475 nm (Pacific Blue™)

Forward scatter detection Photodiode with 488/10 bandpass filter

Side scatter detection PMT with 488/10 bandpass filter
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Fluidics

Signal Processing

General operation Integrated fluidics cart with automated startup, 
shutdown, and cleaning cycles

Sheath consumption 1.1 L/hr, normal operation

<1.0 mL/hr, standby

Sample flow rates Assay dependent, controlled automatically by 
BD FACSCanto clinical software. Nominal rates:

Low = 10 µL/min

Medium = 60 µL/min

High = 120 µL/min

Sample acquisition rate 10,000 events/sec with <10% abort rate 
(8 parameters)

Recommended maximum particle 
size

50 µm

Workstation resolution 262,144-channel resolution

Data acquisition channels 8 to 10 parameters: 6 to 8 fluorescent and 2 scatter 
parameters

Fluorescence compensation No limit to inter- and intra-beam compensation

Pulse processing Height, area, and width measurements available 
for any parameter (BD FACSDiva software)

Time Can be correlated to any parameter

Channel threshold Available for any parameter from all lasers
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Fluidics Cart Specifications

Capacity

Dimensions Height: 64 cm (25.2 in.)

Width: 79 cm (31.1 in.)

Depth: 61 cm (24 in.)

Operational clearances Fluidics cart, side air vent: 20 cm (7.9 in.) between 
air vent and other objects or wall to permit proper 
air flow

Fluidics cart, door air vent: 20 cm (7.9 in.) between 
door and other objects or wall to permit proper air 
flow

Weight $51 kg (112 lb)—fluidics cart only, excluding tanks

$82 kg (180 lb)—with tanks full

Facilities No air supply or vacuum required

BD FACSFlow cubitainer 20 L

BD FACSClean solution 
cubitainer

5 L

BD FACS shutdown solution 
cubitainer

5 L

Waste tank 10 L
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BD FACS Loader Specifications

Carousel compatibility Loader carousels, numbers 1–16

Tube compatibility

• Carousel Accommodates up to 40 uncapped 12 x 75-mm 
tubes

• BD Falcon polystyrene test tubes

• BD Trucount tubes

• BD FACS 7-color setup bead tubes

• Thickness of accumulated labels $0.125 mm (5 mils)
no more than 3 labels thick

Tube sample volume (maximum) $1.07 mL
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Index

Symbols
% T-sum failure 211

Numerics
7-color setup beads 29

label, reading barcodes 27

A
aborts, electronic 223
acquisition

events to record 116
lag 96
manual mode 93
no events 207, 208
optimizing during 97
stopping manually 144
troubleshooting 220
view 96
with Loader 139

Acquisition Dashboard 35
acquisition templates

creating 116
previewing data 125

Adaptive Server Anywhere See database.
adding

FCS files to worklists 109
samples to worklist 106

adjusting
cytometer settings 71
detectors 71
gates 102
PMT voltages 83
setup settings 67
spectral overlap 73
threshold 72, 83

air filter, replacing 161
alcohol, isopropyl 172
analysis

immunophenotyping 116
reusing 125
saving 125
troubleshooting 224
worklists 108

analysis objects
copying 125
missing 224

application menus 32
area scaling, troubleshooting 223
auto-gates, reapplying 104
auxiliary air supply switch 24

B
Bal seal 175

retainer 175
saline deposits 171



242 BD FACSCanto II Instructions for Use

barcode
reader 27

cleaning 42
focal lengths 42
installing 42
optional stand 229

BD FACS Loader 25
BD FACSDiva software

buttons 34
logging out 127
workspace components 34

BD Multitest plots, troubleshooting 213
beads

running setup 51
setup 50
spectral overlap factors 56
target values 55

beam geometry 236
bleeding filters 158
breaker, main circuit 20
Browser

window 35
Bubble Filter Purge procedure 164
bypass tubing, installing 170

C
calculating compensation 87, 88
cap, waste container 157

carousel
controls 139
ID 108
rack

compatible 26
described 26
ID 92
installing 137
loading 93
mixing preferences 136
removing 137
software setup 132
troubleshooting 197
tubes, compatible 26, 239

report 133
case number 91
changing

cubitainers 166
tubes 98

circuit breaker
cytometer 20
fluidics cart 24

resetting 193
cleaning

barcode reader 42
external surfaces 171
fluid 28, 172
fluidics for storage 175

coefficient of variation (CV), high 222
compensation

calculating 87, 88
gating data 87
setup 88
tubes, creating 82

components
BD FACSCanto system 14
fluidics cart 22

computer
shutting down 148, 150
starting 46
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condensation trap 24
emptying 149, 151

connectivity status 33
controls

compensation 82
cytometer 71
export file 92
process 92

cubitainer, changing 166
cytometer

cleaning 171
components 15
controls 71
disconnect error 215
errors 204
not responding 215
not responding to software 192
QC particles 230
settings, adjusting 71
setup 50
specifications 234
supplies 228
warning, objects on top of 15

Cytometer window 36

D
data

analyzing 116
gating 87, 116
recording 118

database
Adaptive Server Anywhere, not 

starting 216
decontamination 160
default optimization settings 69

detector
adjusting 71
arrays

4-2 configuration 18–19
errors during setup 205

diode, forward scatter 17
disabling Loader 197
display, troubleshooting 218
Diva software See BD FACSDiva 

software.
doors

access 15
Loader 138

dry tube, sample runs 196

E
electronic aborts 223
emitted light 17
error messages

check cytometer status 217
Cytometer Disconnected (from BD 

FACSDiva software) 215
Cytometer not responding 215
flow cell access door 48
Hardware key... 217

errors
cytometer 204
detector voltages 205
fluidics pressure 206
laser 206
setup 203
tube pressurization 202
vacuum 202

ethanol 172
events

not showing 203, 207, 208
not showing in plots 220, 221
rate, troubleshooting 208
troubleshooting 223, 224
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Experiment Layout window 116
Experiments

immunophenotyping 116
sample optimization 78

F
FCS files

adding to worklist 109
not created 208

files
optimized setup 69, 70
process control 92

filters
air, replacing 161
bleeding 158
changing 162
fluidic 22
purging 158
waste container cap 157

flow cell 17
about 17
access door 15
checking for bubbles 48
problems 190, 191

flow rates 237
appropriate 118

fluid
leaks

cytometer 194
fluidics cart 198
SIT 193

levels 47
not recommended 172
required 28

fluidics
level

indicators 47
sensors, replacing 183

long clean 160
pressure errors 206
priming 169

fluidics cart
components 22
controls 24
dimensions 238
fuses, replacing 186
maintenance 156, 166
reconnecting tubing 181
troubleshooting 193, 198

fluids
leaks

fluidics cart 225
fluorescence

detection 236
properties, particle 17
signal, troubleshooting 208, 221

focal lengths
barcode reader 42

forward scatter (FSC)
diode 17

fuses, replacing 186

G
gates, adjusting 102
gating

compensation tubes 87
data 116
manually adjusting 102
reapplying auto-gates 104

granularity, particle 17

H

hazard symbol definitions xii
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I
ID, carousel 108
immunophenotyping

analysis 116
Experiment 116

importing
worklists 107, 120

in vitro diagnostic device 13
Inspector window 36
installation kit 228
installing

air filter 161
bypass tubing 170
carousel rack 137
cubitainers 166
fluidics level sensors 183
fuses 186
tubes 57

installing barcode reader 42
instrument

specifications 238
isopropyl alcohol 172

L
Lab Reports

display time 101
reviewing 101, 105
viewing 97, 111

label thickness 239
labels

parameter 116
thickness 239

lag, acquisition 96
laser

errors 206
specifications 235
troubleshooting 191

leaks
cytometer 194
fluidics cart 198, 225
SIT 193

level
fluid 47
sensor 183

light, scattered and emitted 17
Loader

about 25
disabling 197
doors, opening 138
for setup 61
mix settings 94
running cleaning tubes 146

loading tubes 57
logging out, software 113, 127
long clean 160
lymph gate failure 211
lymphosum failure 211

M
maintenance

barcode reader 42
scheduled 154
unscheduled 164

menu commands 32
mixing

Loader 94
preferences 136

moving gates 103
Multitest plots, troubleshooting 213

O

obscuration bar 17
octagon optics 18–19
operating temperature 235
Opticon LG2 Imager 27, 40
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optics
access door 15
filters and mirrors 18–19
octagon 18–19
trigon 18–19

optimization settings file 69, 70
optimizing during acquisition 97, 100

P
panels, choosing 91
parameters

adding or deleting 80
changing 80
labels 116
plot 97
scatter, distorted 222

particle
fluorescence properties 17
granularity 17
shape 17
size 17

photodiode 17
photomultiplier tubes (PMTs), applying 

voltages 83
plenum 16
plots

adjusting gates 102
excessive debris 208, 222
Multitest examples 213
no events 220, 221
parameters 97
troubleshooting 213

populations, troubleshooting 223
power button 15
preferences

mixing 136
user 126

pressure
errors, tube 202
fluidics 206

priming, fluid lines 169
printing setup reports 69
process controls 92
purging filters 158

Q
QC

cytometer 50
messages 210

quality control (QC) 50

R
rack, carousel 108, 239
recording

compensation tubes 87
data 118

removing
carousel rack 137
tubes 59

replacing
air filter 161
fuses 186

reports
Carousel 133
Lab

reviewing 101, 105
viewing 97, 111

printing automatically 141
setup 69

requirements, system 28
re-running

samples 141
tubes 104

results, unexpected 222
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reviewing
Lab Reports 101, 105
worklists 111

running
process control 92
samples 93, 139
setup 51

S
sample injection tube (SIT) 

problems 191, 193
sample prep assistant II (SPA II), 

importing worklists 107, 120
sample stream 17
samples

adding to worklist 106
ID 91
name 91
optimization 78
questionable quality 210
running 93, 118
skipping 106

saving
analyses 125
user-specific optimization 70
worklists 94

scaling, area, troubleshooting 223
scatter parameters, distorted 222
scattered light 17
scheduled maintenance 154
security module troubleshooting 217
sensitivity, cytometer performance 235
sensors, fluidics 183
settings

adjusting 71
default 70
multiple users 70
optimization, saving 70
single user 70

setup
about 50
adjusting settings 67
age 50
beads 50
compensation 88
errors 203
failure 59, 63
manual mode 56
reports, viewing 69
running 51
troubleshooting 203
using the Loader 61

shape, particle 17
sheath fluid consumption 237
shutting down computer 150
side door, cytometer 15
signals

no fluorescent 208, 221
troubleshooting 223

size, particle 17
skipping

samples 141
tubes 106

software
logging out 113
menus 32
not responding 199, 216
troubleshooting 199, 215

specifications
cytometer 234
fluidics cart 238
loader 239

spectral overlap
adjusting 67, 73
factors, beads 56

spillover, manual adjustment 73
starting computer 46
statistics, troubleshooting 224
status bar 33
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stopping acquisition manually 144
stream, sample 17
supplies

cytometer 228
ordering 227

system requirements 28

T
target values, setup beads 55
technical specifications 239
threshold

adjusting 72, 83
troubleshooting 223

time
display (Lab Report) 101
pre-acquisition 96

timeout, unload tube 98
toolbar, workspace 34
trap, condensation 24

emptying 149, 151
trigon optics 18–19

troubleshooting
acquisition 220
analysis 224
CVs 222
electronic aborts 223
event rate 208, 222
events 224
FCS files 208
general software 199, 215
Multitest plots 213
no events 203, 207, 208
plots 208, 213, 220, 221, 222
populations 223
QC messages 210
scatter parameters 222
screen display 218
security key 217
setup 203
signals 208, 221, 223
statistics 224
status messages 217
window extension 223

Trucount tubes 92
tubes

changing 98
compatible 26
compensation 82
loading 57
pressurization errors 202
removing 59, 68, 85, 98
re-running 104
sample volume 239
skipping 106
timeout during unloading 98
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U
unload tube timeout 98
unscheduled maintenance 164
USB security module 217
user preferences 126

V
vacuum error 202
viewing Lab Reports 97, 111
views

Browser 35
Cytometer window 36
Worksheet 37
Worksheet window 37

voltage
adjusting PMT 83
compensation and 87
fluidics cart fuses 188

W
waste container

cap 157
emptying 156

window
Acquisition Dashboard 35
BD FACSDiva software 

workspace 34
Browser 35
Canto software components 32
Cytometer 36
extension, troubleshooting 223
Inspector 36
Worksheet 37

worklists
adding

FCS files 109
samples 106

analysis 108
importing 107, 120
opening 110
reviewing 111
saving 94

Worksheet window 37
workspace toolbar 34
workstation

shutting down 148, 150
starting 46
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